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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©June 2012

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive

Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia

EuP-Standby and Off Mode Power Consumption Statement:

Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode or standby mode:

« Standby Mode <2W
» Off Mode <1wW
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereis no guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

\ A/
2§
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-

pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit:

Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19V, 6.3A (120W) minimum.

This Computer’s Optical Device is a Laser Class 1 Product

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

Preface

1. Don’tdrop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

Do not placeit on an unstable
surface.

Do not place anything heavy
on the computer.

2. Keep itdry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

__

Do not leave it in a place where
foreign matter or moisture may
affect the system.

Don't use or store the computer
in a humid environment.

Do not place the computer on
any surface that will block the
Vents/Fan Intakes.

\1
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other

strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power until
you properly shut down all pro-
grams.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your compulter.

-

5. Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.

VIl
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Power Safety
The computer has specific power regquirements:

. . N\ A/
» Only use a power adapter approved for use with this computer. ﬂ:
* Your AC/DC adapter may be designed for international travel but it still requiresa Power Safety
steady, uninterrupted power supply. If you are unsure of your local power specifications, Warning
consult your service representative or local power company.

« The power adapter may have either a 2-prong or a 3-prong grounded plug. The third Before you undertake
prong is an important safety feature; do not defeat its purpose. If you do not have access 1 b e aubt EICEEs

. e S dures, make sure that
to acompatible outlet, have a quaified electrician install one. you have turned off the

* When you want to unplug the power cord, be sure to disconnect it by the plug head, not power, and discon-
by itswire. nected all peripherals
» Make sure the socket and any extension cord(s) you use can support the total current and cables (including
load of all the connected devices. telephone lines and

» Before cleaning the computer, make sure it is disconnected from any external power power cord).

supplies (i.e. AC/DC adapter or car adapter). G —

your battery in order to
Do not plug in the power Do not use the power cord if | Do not place heavy objects prevent  accidentally
cord if you are wet. it isbroken. on the power cord. turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
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General Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.

Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of adamaged battery. Always dispose of batteries carefully. Batteries
may explode or lesk if exposed to fire, or improperly handled or discarded.

Keep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

N\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

SAE
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

agrwbnE

N o

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won'’t need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your “papers” are handy.

\ A/
A&
Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer

from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

Xl
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

» Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

» Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
afootrest if necessary.

» Useachair with aback and adjust it to support your lower back comfortably.

» Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

» Take periodic breaks if you are using the computer for long periods of time.

Remember to:

» Alter your posture frequently.

e Stretch and exercise your body severa times aday.

» Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

» Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

» Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
» Position the display directly in front of you at a comfortable viewing distance.

» Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

» Set the Windows Power Plansto turn the screen off after afew minutes of screen idle time.

» Usearotating, moving or blank screen saver (this prevents an image from being displayed too long).
» Rotate desktop background images every few days.

» Turn the monitor off when the systemis not in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may devel op sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear devel ops contact your service center.

XVI
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

» Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, card reader), TouchPad & Mouse & Audio Features.

e Chapter 3  The computer’s power management options.

» Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

» Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructionsfor upgrading your computer.

» Chapter 7 A quick guide to the computer’s PC Camera, WirelessLAN, Wireless Display, Fingerprint,
Bluetooth & WLAN Combo and TruStudio Audio modules (some of which may be optional
depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on the Control Center.

» Appendix C Information on the NVIDIA Video driver controls.

» Appendix D The computer’s specification.

. |
Overview 1 -1



Quick Start Guide

Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “ Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “ Upgrading The Computer”
on page 6 - 1 inthe User’s Manual. Y ou may also find the notes marked with a ~# of interest to you.

Beginners and Not-So-Advanced Users

4 If you are new to computers (or do not have an advanced knowledge of them) then
Notes the information contained in this Quick Start Guide should be enough to get you up
. and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the

boxes with the mark "
above to find detailed remainder of the User’s Manual), but do not worry if you do not understand every-
information about the | thing the first time. Keep this manual nearby and refer to it to learn as you go. You
computer’s features. may find it useful to refer to the notes marked with a ~# as indicated in the margin.
For amore detailed description of any of the interface ports and jacks see“ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.

Overview 1 -3
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find that this manual refers to the Windows 7
operating system.

4

Windows OS

In order to run Windows 7 without limitations or decreased performance, your computer requires a minimum 1GB of sys-
tem memory (RAM), however if you are running Windows 7 64 bit your computer requires a minimum 2GB of system
memory (RAM).

. |
1 -4 Overview



System Startup

1.
2.
3.

Quick Start Guide
Remove all packing materials and place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 135 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

Press the power button on the top right of the computer for about 2 - 3 seconds to turn the computer “on” (note
that the power LED on the front of the computer will turn from orange to green when the computer powers
on).

4

Shutdown

Note that you should always
shut your computer down by
choosing the Shut Down
command from the bottom
right of the Start menu in
Windows. This will help pre-
vent hard disk or system
problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

System Startup 1-5
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Figure 1- 2 System Map: LCD Panel Open

LCD Panel Open

1. Built-In PC Camera
(Optional)

LCD

Power Button

GPU Button
Speakers

Top Case LED
Indicators)

Hot Key Buttons
Keyboard

Built-In Microphone
0 Touchpad & Buttons

ok wd

1 -6 System Map: LCD Panel Open

N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator or
on-screen icon to see if the
modules are powered on or
not (see
/

).
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LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Icon Color Description Icon Color Description

Number Lock is Activated

Orange AC/DC Power is Plugged In Green P P )

e~ 8

Caps Lock is Activated
W, |) Green The Computer is On — Green : 3
P m (oFF i'l:
i d

S Scroll Lock is Activated

Blinking

The Computer is in Sleep Mode EI Green Sci Sc
Green P P m m
—~ | |~ |

Orange The Battery is Charging

m Green The Battery is Fully Charged
Blinking The Battery Has Reached Critically
Orange Low Power Status

Table 1 -1 - Front Left LED Indicators
See overleaf for information on the Top Case LED indicators.

LED Indicators 1 -7
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Y

Icon Color Description
Green UMA Mode Activated (GPU Button)
GA
Oo Orange | Optimus Mode Activated (GPU Button)
.."/" g Orange | NVIDIA Discrete GPU (dGPU) Activated
E e Green | Intel Integrated GPU (iGPU) Activated
ﬁ (1) White Hard Disk Activity
The (optional) WLAN Module is
Green
Powered On
() © . .
The (optional) Bluetooth Module is
Orange
Powered On
White The Computer is Powered On

1 -8 LED Indicators

Table 1 -2 - Top Case LED Indicators
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4

Other Keyboards

Hot Key Buttons & Keyboard

Press the hot key buttons on the computer to toggle the appropriate function on/off.

Icon Color Description If your keyboard is dam-
Green UMA Mode Activated (GPU Button) ﬁg:ki (: g}? :ngu; t %in(t:;ﬁ
GA :

O Orange | Optimus Mode Activated (GPU Button) Eseb 3”3(; if“da“tj US!ﬁ
eypoard. e system wi

@ 0 Power On/Off the (optional) PC Camera ?ne;g;ﬁ;d Sgiﬂ;‘: asuszz
cial  functions/hot-keys

Mute On/Off unique to the system’s
9 regular keyboard may not

On/Off the (optional) Wirel ok
Power On the (optional) Wireless LAN
(9)
((x)) (3] Module NumLk & ScrLk

( I ’ Power the Computer On/Off HO('jd dz‘r’]"” th’\‘j F'EkKey
an elther um or

ScrLk to enable number
Table 1 - 3 - Hot Key Buttons or scroll lock, and check

/ the LED indicator for sta-
tus.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Hot Key Buttons & Keyboard 1 -9
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Keyboard

The keyboard has an embedded numerical keypad for easy numeric data input, and features function keysto al-
low you to change operational featuresinstantly. See Table 1 - 4, on page 1 - 11 for full function key combina-

tion details.

l i “Fl ’] [-Fz H] ra @1 !'H ﬂ‘ stq Hrs HF?[ m, [Fﬂ _ﬂj IIFB_ Hml__.] lm | [F‘zﬂfru". :;,sﬂ” _"i\__ [ Dol ] [Hume ][ End ‘Ifﬂ‘{f Hf_’ﬂﬂl:'
=1 1le = 1[5 Function Keys (= ) |
| | s el U [HE==2 D0k
PaylPause Ky v (e [R][T "Y u “": E [ scrikkeys][7 |[8 [
l || H J L L [ U H\ wome | [t || poup
= T F - e +

e e o [ [ = [ A

i ) L —_— — , iNumerlcaI Keypad
oshin ‘2 HX c HV HB N HM {f | 7| osmn ‘ N 1B e |
cirt Hrc Ay || an H Al l ctri “ - v S 0 H ‘
L | ! ! | | Ins Del

Fn Key

Figure 1 - 3 - Keyboard

.|
1-10Keyboard
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Quick Start Guide

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. Visual in-

dicators (see the table below) are available when the Hot Key driver isinstalled.

Keys Function/Visual Indicators Keys Function/Visual Indicators
Fn+~ Play/Pause (in Audio/Video Programs) Fn + Esc Control Center Toggle (see over)
Fn +F1 Touchpad Toggle % e X Fn +F8/F9 Brightness Decrease/Increase QI
4 | — .
Turn LCD Backlight Off - . Eﬂ
PC Camera Power Toggle £ )| | @
Fn+F2 (Press a key to or use Touchpad to turn on) Fn+F10 9 ‘@m, o o
Fn+F3 Mute Toggle (G ! "ri ! | Fn + F11 WLAN Power Toggle m WJ
4 J a
Fn + F4 Sleep Toggle Fn + F12 Bluetooth Power Toggle m I =
Fn +F5/F6 Volume Decrease/Increase Q
Fn+ F7 Display Toggle
See also Table 1 - 1, on page 1 - 7 for Number Lock, Caps Lock and Scroll Lock indicators

Table 1 - 4 - Function Keys & Visual Indicators

Keyboard 1-11
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Control Center

Press the Fn + Esc key combination, or double-click the icon n in the notification area of the taskbar to
toggle the Control Center on/off. The Control Center gives quick access to frequently used controls and en-
ables you to quickly turn modules on/off.

Control Center @ ﬂ Q, ~ g

Click on any button to turn any of the modules (e.g.

PowerSaving Flight Entertainment Cuiet Ferformance @) UserDefine
TouchPad, Camera) on/off.
! . _ 1, y
Click on the power conservation modes to switch be- .‘@- ‘ = 1; 55 G
tween Performance, Balanced or Energy Star modes 0 1005 N

(see page 3 - 10). To remove the Power Conservation Power Status Brightress Volume

Modes screen just click in a blank area of the icon or

press a key on the keyboard.
Desttop

Display Switch  Time Zone Bici ol

DB

Touch Pad Camera Wireless Bluetooth

8 & 8

Click on the buttons (or just click and hold the mouse but-
ton) to adjust the slider for Brightness/Volume.

Click on Display Switch and click to choose a display
mode from the menu (see page C - 13).

i

Table 1 -5 - Control Center

1-12 Control Center
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System Map: Front & Left Views Figure 1 - 4

Front & Left Views

LED Indicators
Security Lock Slot
USB 2.0 Port
S/PDIF-Out Jack
Microphone-In
Jack
Headphone-Out
Jack

7. Optical Device

ﬁ Drive Bay
CD/DVD Emergency Eject

S

o

2L
THX TruStudio
Audio

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption)
you may push the end of a straightened paper clip into the emergency eject hole. Do not
use a sharpened pencil or any object that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the system is accessing it. This may
cause the system to “crash”.

Note that you will need

to install the THX
TruStudio audio appli-
cation in order to get
maximum audio per-
formance.

Disk Eject Warning

Don't try to eject a CD/DVD while the system is accessing it. This may cause the system
to “crash”. Stop the disk first then eject it, or press the stop button twice.

System Map: Front & Left Views 1 - 13
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Figure 1-5 System Map: Right & Rear Views

Right & Rear Views

1. Multi-In-1 Card

Reader

2 * USB 3.0 Ports

3. Combined eSATA/
USB 3.0 Port

N

4. HDMI-Out Port
5. RJ-45 LAN Jack
6. External Monitor
Port
7. DC-In Jack 4

8. Vent/Fan Intake Multi-In-1 Card Reader

/ The card reader allows you to use the most popular digital storage card formats:
MMC (MultiMedia Card) / RS MMC

SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Ports

USB 3.0 ports are denoted

by their blue color; USB 2.0 The card reader features a push-in/push-out card insertion and ejection mechanism. Simply push the
ports are colored black. card to insert and eject it, however Ms Duo cards require an adapter.

Note that the USB 3.0 port HDMI Port

requires a driver installation Note that the HDMI Port supports video and audio signals to attached external displays (also see
(see USB 3.0 on “HDMI Audio Configuration” on page C - 22). Note that THX TruStudio Pro will be disabled when
page 4 - 7) and is not oper- you are connecting to an external display through an HDMI connection (see page 7 - 57).

ational under DOS.

1-14 System Map: Right & Rear Views
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System Map: Bottom View Figure 1 - 6

Bottom View

1. Component Bay
Cover

Battery

Primary HDD Bay
Fan Outlet/Intake

o

4

Battery Information

Always completely dis-
charge, then fully
charge, a new battery
before using it. Com-
pletely discharge and

\ A/
7£l< charge the battery at

CPU least once every 30 days
. . or after about 20 partial

The CPU is not a user serviceable part. discharges. See “Bat-
Overheating tery Information” on

page 3 - 11 for full in-

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake T

while the computer is in use.

System Map: Bottom View 1 - 15
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Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usualy be placed in the Start menu and/or the desktop. Right-click the Start menu

icon 4, and then select Propertiesif you want to customize the appearance of the Start menu.

3 1 Covmen Pt 8 bl G o B+

1 it 'ﬂ
J
i - = 3 -
. D . ] A
L & " ¢
“. . r P u g
% Magn &, -, -
.. Solital ke

e
o

o Cancei

_ i e R
...Click here to toggle Category, View

@ s x B W
L)

@ >
Properties . Whsorun MG
O Eftods Rg A Figure 1 - 7 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
inWindows (e.g. power, video, network, audio etc.). Windows 7 provides basi c controlsfor many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

1-16 System Map: Bottom View
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Video Features
NVIDIA® Optimus™ Technology

NVIDIA® Optimus™ technology is a seamless technology designed to get best performance from the graphics
system while allowing longer battery life, without having to manually change settings. When the computer isin
OptimusModeit will automatically switch between the integrated UMA (Unified Memory Architecture) GPU
(iIGPU) and the discrete GPU (dGPU) when required by the applicationsin use. This switch is seamless to the
user and does not require any use of the GPU button (see“ NVIDIA® Optimus™ Technology” on page C - 2).

The GPU button ye&” allows you to switch between the Optimus M ode (where GPU switching is automatically
handled) and UM A Mode (for constant power-saving with the integrated GPU only).

Icon Color Description Note
Green UMA Mode Activated
GA
O Orange Optimus Mode Activated
_ _ The GPU LED indicators [ +*7 4 wil
ﬁ Green Integrated GPU (iGPU) Activated display which GPU is currently in use
.."'/" Orange Discrete GPU (dGPU) Activated

Table 1 - 6 - GPU Modes & GPU LED Indicators

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows 7 (see over). For more detailed video information see “ Video Driver Con-
trols’ on page C - 1.

Video Features 1 - 17
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To access Display (Control Panel) and Screen Resolution in Windows:

Click Start and click Control Panel.

Click Display (icon) - In the Appearances and Personalization category.

Click Adjust Screen Resolution/Adjust resolution.

Alternatively you can right-click the desktop and select Screen resolution.

Use the dropbox to select the screen Resolution @ (Figure 1 - 8).

Click Advanced settings @ (Figure 1 - 8) to bring up the Advanced properties tabs.

=T

ok wnE

"= ) Contiol Panel b All Control Panel iems » Display b Screen Resolution v | 3 ll search Contrel Panet o

Change the appearance of your display

. Mobile

Display: 1. Mobile PC Display ~

Resolution:

Advanced scttings

Connect to 2 projector (or press the & key and tap P)
Make text and other items larger or smaller 9

What display settings should I choose?

oK Cancel Apply
[ ok |

Figure 1 - 8 - Screen Resolution

1 - 18 Video Features
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To access the I ntel (R) Graphics and Media Control Panel:

1. Click Advanced settings @ (Figure 1 - 8 on page 1 - 18) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button) @ (Figure 1 - 9) in the Intel Graphics & Media Control Panel tab.

OR

3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Click the icon E O (Figure 1 - 9) in the taskbar and select Graphics Properties from the menu.

OR

5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View.

6. Choose the application mode (Basic, Advanced or Wizard) required.

Generic PnP Manitor and Intel(

[ adapter | Monitor e L

| B 1ntel(R) Graphics and Media Contral ‘ ‘ Grap_l‘i'u*sP T 5
Intel® Graphics and Media "

Control Panel

Graphics and Mudia
Control Panel

Grap
Exit Tray

Advancad Mode

Display  [guiltin Display

Intel® Graphics and Media
Refresh Rate [s0p Hz ~| Control Panel

Rotation  [otate To Normal -

1136 AM
01/14/2012

el

Scaling | Waintain Display Scaling -

Options and Support

Figure 1 - 9 - Intel Graphics and Media Control Panel
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To access the NVIDIA Control Panel:
1. Right-click the desktop and select NVIDIA Control Panel @ (Figure 1 - 10).

OR

2. Double-click the icon E @ (Figure 1 - 10) in the Windows control panel.

View
Sort by
Refresh

Paste
Paste shortcut

Graphics Properties...
Graphics Options

MVIDIA Control Panel

=

Mew

Screen resolution

-
@ Gadgets
il

Personalize

53 » ControlPanel » Al Contrl Panel tems »

. )| Search Controt Panel

NVIDIA Control

File Edit Deskiop 3D Settings

Help

Que -Q | B

Select a Task...

- 3D Settings
(S = vith preview

Manage 30 settings

i LSetPhysX configuration

= Video
Adjust video color settings
Adiust video image settings

Adjust your computer’s settings

@i Indexing Options M
&= Location and Other
S [5)
< Keyboard i

&a Network and Sharing

=] Noti
AN Conter Notification Area Icons

Performance Information

P

@ arental Controls [ Ipawsainn

&3 Phone and Modem \Q Power Options

e Recovery G Region and Language
@ souna §  Speech Recognition
B4 system L asioar and start Menu

Viewby: Largeicons ¥

N7 Internet Options

NVIDI trol Panel
Perso n

m Programs and Features

% RemoteApp and Desktop
Connections

@ synccenter

(M Troubleshooting

System Information

This page allows you to prview changes you make to the image and rendering settings. These wil be your default seffings for your

Adjust Image Settings with Preview

hardwars-acoslerated 3D appiications that wtize Direct3D or OpenGL.

Performance:

What do T look for?
Moving towards the
Performance side wil
increase frame rate,
but curved lines wil
appear janged.

Moving towards the
Quality side will mprove
the smoothness you
can see on curved lines.

Desaription:

Preview:

Take me there

et the 3D application decide
Use the advanced 30 image settings

se my preference emphasizing:  Quality

Performancs Qualty

Toggles between playing and pausing the animation.

Restore Defaults

Figure 1 - 10 - NVIDIA Control Panel
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Power Options

The Power Options (Hardwar e and Sound menu) control panel icon in Windows (see page 1 - 15) alowsyou
to configure power management features for your computer. Y ou can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create anew plan. Click Change plan settings and click Change advanced power settingsto access further con-
figuration options.

Pay attention to the instructions on battery care in “ Battery Information” on page 3 - 11.

'# » Control Panel » All Control Panel ltems » Power Options. w]ég | Search trof My o '# « Power Options » System Settings ~ | 49 | search Control Panet £
L
Select a pawer plan Define power buttons and turn on password protection
] On battery =9 Plugged in

g o casal b @ vinenpress the pover bution [sieen -
Do ng

When I press the sl tton: LI =

@ en I press the sleep buttos Hibernate Sleep.

uter's performance where possible. P Shut down

@ When1ciose the lic Sieep <] [steen -

can access your data without entering the correct
our user account password

D« d
When your computer wakes from sleep, anyone can access your data because the computer isn't

.

Figure 1 - 11 - Power Options
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Storage Devices, Audio & Mouse

Chapter 2. Storage Devices, Audio & Mouse

Overview

Read this chapter to learn more about the following main features and components
of the computer:

* Hard Disk Drive

* Optical Device

e Multi-in-1 Card Reader

e Audio Features

» TouchPad and Buttons/Mouse

. |
Overview 2 - 1
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Hard Disk Drive

\ A/
’I'l‘ The hard disk drive(s) is(are) used to store your data in the computer. The hard
Power Safety disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives
S e e | with aheight of 9.5 mm. The hard disk(s) is(are) accessible after removing the hard
eIl disk bay cover (primary hard disk drive) or component bay cover (secondary

celeniEs OIS hard disk drive) from the bottom of your computer as seen below.
computer please ensure

WEEGERPECIRERERE SR Further details on removing and inserting the hard disk are availablein “ Upgrading

SO CERCRLER S  the Hard Disk Drive(s)” on page6 - 7.
power, and that the ma-

chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Secondary HDD

Figure2-1 Primary HDD

Hard Disk Location

2 - 2 Hard Disk Drive
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Optical Device

Thereisabay for a5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “ Storage” on pageD - 4). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “ Boot Menu” on page 5 - 13).

Loading Discs

Toinsert aCD/DVD, press the open button @ and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’ s spindle). Gently push the CD/DVD tray in until itslock “clicks’ and you
are ready to start. The busy indicator @ will light up while data is being accessed,
or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency gject hole
© to open thetray.

4

Sound Volume
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the notification
area to check the set-
ting.

Peripherals must be
connected before you
turn on the system.

Figure2-2
Optical Device

Optical Device 2 - 3
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Handling CDs or DVDs

\ A/

7£l< Proper handling of your CDS/DVDs will prevent them from being damaged. Please
follow the advice bel ow to make sure that the data stored on your CDS/DV Ds can be

CD Emergency Eject
accessed.

If you need to manually

SRR e RETERCRE  Note the following:
an unexpected power

LICERT R CE g EVAR . Hold the CD or DVD by the edges; do not touch the surface of the disc.
SEEREERCIERSRERE  «  Use aclean, soft, dry cloth to remove dust or fingerprints.
fg{g'ﬂiﬁgrgﬁfej‘zg « Do not write on the surface with a pen.

L S e ¢ Do not attach paper or other materialsto the surface of the disc.
SeNeRE TEEEERETER o Do not store or place the CD or DVD in high-temperature areas.
SUEERCEUEIRE SR UIIERE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SOLERE S EEECS « Do not bend the CD or DVD.

d b lodged i .
?hne hoﬁfome =8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical Device
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DVD Regional Codes
To change the DVD regional codes: Z

DVD Region Note

1. Go tothe Control Panel

2. Double-click Device Manager (Hardware and Sound), then click the + next to
DVD/CD-ROM drives.

3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and
select the DVD Region (tab) to bring up the control panel to allow you to adjust the
regional code.

DVD region detection is
device dependent, not
OS-dependent. You can
select your module’s re-
gion code 5 times. The
fifth selection is perma-
nent. This cannot be al-

R U—

J‘Eenaill DVD Region i‘Jqumes | Driver I Detailsl

* Region1-USA & Canada

Mozt DVDe are encoded for play in specific regions. To play a
regionalized DWVD on your computer, you must set your DVD drive to
play discs from that region by selecting a geographic area from the
following list.

CAUTION You can change the region a limited number of times.
After Changes remaining reaches zero, you cannot change the region even
i you reinstall Windows or move your DVD drive to a different computer.

Changes remaining: 5

To change the cument region, select & geographic area, and then click OK.

United Arab Emirates -

United Kingdom

Uruguay

Uzbekistan

Vanuatu

Vatican City -

Cumrert Region: ]Nat Selected
New Region: 1Reginn i

Region 2 - Western Europe, Japan,
South Africa, Middle East & Egypt
Region 3 - South-East Asia, Taiwan,
South Korea, The Philippines, Indo-
nesia, Hong Kong

Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand
Region 5 - N Korea, Russia, Eastern
Europe, India & Most of Africa

Region 6 - China

tered even if you change
your operating system
or you use the module in
another computer.

Figure2-3
DVD Region Codes

Optical Device 2 - 5
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Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

Push-Push Card
Reader

The card reader fea-
tures a push-in/push-
out card insertion and
ejection mechanism.
Simply push the card to
insert and eject it, how-
ever Ms Duo cards re-
quire an adapter.

Figure2-4
Left View

1. Card Reader

Multi-in-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see” Card Reader” on page4 - 7).

e MMC (MultiMediaCard) / RSMMC
* SD (SecureDigital) / Mini SD / SDHC/ SDXC
e MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

. |
2 - 6 Multi-in-1 Card Reader
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Audio Features .
b/ \Y
Y ou can configure the audio options on your computer from the Sound - control
panel in Windows, or from the Realtek HD Audio Manager g icon in the notifi-

cation area/control panel (right-click the taskbar notification areaicon g to bring up E‘]‘;‘;ﬁhf‘rfg%ﬂ'r:gf: o

an audio menu). The volume may also be adjusted by means of the Fn + F5/F6 key BRSNS e e el

combination (see Table 1 - 4, on page 1 - 11). to get maximum audio
_ _ performance. See

THX TruStudio Audio

@]] Sound Manager —
T oot ot ﬂ#} ey u_/‘:m Ml
w2z, Audio Devices Main Vohume o —— NS
i ] || Bever I
4B, e sons e e — | Figure2- 5
i ® Realtek Audio
@ Windows Media Player R | B mqm. Man ager
r @
EE Wolume Control /
(E': ol Becoier ot s Volume Adjustment
s Front left and nght
Right-click the icon n The sound volume level is
to access the menu set using the volume con-
b —_— trol within Windows (and
above. 5 REALTEK L8

the volume function keys
on the computer). Click the
See “HDMI Audio Configuration” on page C - 22 for a description of the audio configura- volume icon in the notifica-
tion when connecting an HDMI supported display device. o ez v uzeh duz sae
See “THX TruStudio Pro Audio” on page 7 - 56 for more information on the THX TruStudio
Pro Audio setup.

ting.

Audio Features 2 - 7
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Figure2-6
Realtek Audio
Manager -
Recording Setup

Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-

tions below:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel)
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon H and select
Sound Manager).

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4.

-

& REALTEK

2 - 8 Audio Features
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TouchPad and Buttons/Mouse

: . e
The TouchPad is an alternative to the mouse; however, you can also add a mouse to _
your computer through one of the USB ports. The TouchPad buttons function in Mouse Driver
much the same way as a two-button mouse. If you are using an ex-

ternal mouse your op-
erating system may be
able to auto-configure

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’'s user docu-
mentation for details.

TouchPad and Buttons/Mouse 2 - 9
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Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device's user docu-
mentation for details.

Figure2-7
Mouse Properties
(ELAN tab) &
Taskbar Icon

Elan TouchPad

Once you have installed the TouchPad driver (see “ TouchPad” on page 4 - 7) you
can configure the functions by double-clicking the TouchPad driver icon £ in the
notification area of the taskbar (or from Optionsin the ELAN tab in the Mouse
control panel in Windows). Y ou may then configure the gestures and optionsto your

preferences.
_* Mouse Properties - M
s

| Buttons | Pointers | Pointer Options | Wheel | Hardwar(| 5"3 E'—AND
Driver Version : \/
Device:
 Device |__Pot | Enable |
|__ Elan Smart-Pad PS/2 Enable

] Stop Device i@
N———

[~ Disable when extemal USB pointing device plug in
: % Display Dynamic lcon _-_
m " Display Static lcon &3

" Do Not Display lcon

[ OK ] [ Cancel Apply

r— E| AN Pointing Device

e @ @

Customize...

P o g i gy 2 LOLPM
=% @20 9/27/2011

2 - 10 TouchPad and Buttons/Mouse
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The Elan Smart-Pad control panel allows you to use a specific gesture (action) on
the surface of the TouchPad to perform specific actions to manipulate documents,
objects and applications.

Click themenu tabs (One-finger, M ulti-finger or Additional) and then the function
button on the left to access the Configuration controlsin the right panel. Click the
checkbox to Enable most of the controls and click Apply to save the settings. Click
the close icon 3 or Y es to close the control panel.

(‘5 Elan Smart-Pad

| One-finger | Multi-finger | Additional .

Configuration a ?

o

‘One-finger Click/Select

Two-Finger Middle Button -
Figure2-8

Drag and Drop Iiece Sandes u”" E Smart-Pad Control
e Panel (Button)

Button

Edge Scroll

& dda

Set all to default Ok Cancel Apply

TouchPad and Buttons/Mouse 2 - 11



Storage Devices, Audio & Mouse

Click the Function Description [ 7] button to get a detailed description of any func-
tion.

Click the Default e button to set any of the functions to the default setting.

] |

One-finger TW [ Additional Copyright

Edge Scroll supports most scrollable applications, such as word

Function Description c ?

Tapping —
Edge Scroll allows users to easily scroll windows and applications with Functuc
the right and bottom edges of the touchpad.

. processing documents, spreadsheets, internet explorer and large
F| gUI’e 2 - 9 Biion digital images. It also works with other scrollable items, such as combo
Smart-Pad Control u boxes.
Panel with ' Enable 1
Function #’ iagasliEing g;l:lllzitr:;e appropriate check box to enable vertical scrolling or horizontal
Description

If Edge Scroll does not respond, make sure that the appropriate check
boxes are selected and that the window or item you have clicked on is
scrollable. To scroll vertically, tap the right edge of the touchpad and =
Edge Scroll drag your finger up or down. Te scroll horizontally, tap the bottom edge of
the touchpad and drag your finger left or right.

Scroll Speed

Drag the slider to setthe scrolling speed.

NOTE: -
I Set all to default Ok Cancel Apply

2
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One-Finger

Tapping

The Smart-Pad supports one, two and three finger tapping, al configured from the
Tapping control panel inthe One-finger tab. Y ou can configuretwo or threefinger
tapping to perform a number of different functions by selecting them from the drop-

down menus provided. )
' B Figure2-10
s Tapping

Button
The left and right TouchPad buttons may be configured to perform any action listed
in the Button drop-down menu.

Figure2-11
Button

TouchPad and Buttons/Mouse 2 - 13
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Figure2- 12
Drag and Drop

Figure2- 13
Edge Scroll

Drag and Drop

Y ou can select the different drag and drop methods from the menu provided. The ob-
ject can be released when you lift the finger off the TouchPad, when you tap again
or after a set time delay.

Edge Scroll

Edge Scroll can be configured to use a single finger to scroll vertically or horizon-
taly. To scroll vertically, tap the right edge of the TouchPad and drag the finger up
and down. To scroll horizontally, tap the bottom edge of the TouchPad and drag your
finger left or right.

2 - 14 TouchPad and Buttons/Mouse
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Multi-Finger

Zooming
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
dlide them apart to zoom in, or closer together to zoom out.

T Figure2 - 14
Zooming

Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Tap the pad surface and slide both fingersin the
direction required (vertically or horizontally aslong as the option is selected).

Figure2- 15
Scrolling

. |
TouchPad and Buttons/Mouse 2 - 15
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Rotation

Y ou can rotate objects by using atwo-finger gesture. Touch and rotate using two fin-
gers on the pad in the direction required. Alternatively place a finger down on the
pad and rotate the other finger around it in a circular motion (clockwise or counter-
clockwise).

Figure2 - 16 :
Rotation l

Swipe Page

Thisgestureisused to activate a Page Up/Page Down operation. Swipethreefingers
quickly to the left to go to the previous page, or to the right to go to the next page.
After you release your fingers from the pad the page changes, and make sure to lift
your fingersimmediately after the page change.

Figure2- 17
Swipe Page

2 - 16 TouchPad and Buttons/Mouse
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Fast Keys
The Fast Keys gesture alows you to switch windows or open My Computer. 2

Figure2- 18
Fast Keys

My Computer (Fast Keys)
Tap three fingers simultaneously on the pad and then move them up until you get to
the My Computer window, you can then release the fingers from the pad.

Switch Windows (Fast Keys)
Tap three fingers simultaneously on the pad and then move them down until the ac-
tive window switches, you can then use asinglefinger to select the window required.

. |
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Storage Devices, Audio & Mouse

Additional
Palm Tracking
Thisfeature helps guard against accidental contact such as palms resting on the pad.

Use the dlider to adjust the sensitivity of the feature as appropriate.

Figure2- 19
Palm Tracking

Smart Motion

Smart Motion makes it easier to drag objects across the screen or move the pointer
across long distances. When a finger reaches the edge of the TouchPad, holding the
finger on the edge of the TouchPad will allow the cursor to continue moving until
the finger islifted.

Figure2 - 20
Smart Motion

. |
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Slow Motion
Slow Motion allows you to slow down the cursor movement for more precise con-
trol. Pressing and holding key (configured from the drop-down menu) will enable
this feature.
Figure2- 21
Slow Motion

. |
TouchPad and Buttons/Mouse 2 - 19
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- || Power  management
. . functions will vary slight-
agement conserves power by controlling individual components of the computer

ly depending on your

(the monitor and hard disk drive) or the whole system. operating system. For
. more information it is
This chapter covers: best to refer to the user’s
« The Power Sources manual of your operat-
« Turning On the Computer 19 system:
« Power Plans (Note: All pictures used
. Power-Saving States on the foIIowir_lg pages
» Configuring the Power Buttons grse_;rom the Windows 7

* Power Conservation Modes
» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devicesinto low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-In jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button on the top left of the computer for about 2 - 3 seconds to
turn the computer “on” (note that the power LED on the front of the computer will
turn from orange to green when the computer powers on).

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see“How do | completely discharge the battery?”

on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 11.

3 - 2 The Power Sources
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow- Z
er button on the front panel. Forced Off

; ; If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ i s T 2 A o]

Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and | ey combination doesn't
holding the power button for longer than this will shut the computer down). Use || work, press the power

Power Optionsin the Windows control panel to configure this feature. button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

4
Power Button as
Shut Down Stand by or

Note that you should always shut your computer down by choosing the Shut Down com- Hibernate Button

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk
or system problems.

You can use the OS'’s
Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
Lock bernate mode (see your
OS’s documentation, or
“Configuring the Pow-

- w— Sleep er Buttons” on page 3
Hibérmate - 8 for details).

Switch user

Default Program Log off

Help and Suppo

Restart

Turning On the Computer 3 - 3
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Power Plans

The computer can be configured to conserve power by means of power plans. You

4

Resuming can use (or modify) an existing power plan, or create a new one.
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

see Tables - L ON | 14 send the computer into Sleep after aperiod of inactivity.

page 3 - 9 for informa-
tion on how to resume

e £ [ReEreenn Click Change plan settings and then click Change advanced power settings to ac-

cess further configuration options in Advanced Settings.

State.
Password
" = ANl Conticd Panel leens » Power Options » it Plan Sartings.
It is recommended that ” ,
hange settings for the plan: Balanced
you enable a password Choose the seep and isplay settiogs Bt yos
on system resume in or- W Prugordin
der to protect your data. it
Balanced [Active] -
10 mewey
Balanced
»| |30 mienes - Require a password on wakeup
Figure3-1 '
POWGI’ Plan f Desktop background settings
Ad van Ced Settl n g s ::::m Adapter Settings
(Win 7) i £ US8 settings
= ¥ Pawer buttons and lid
Bestore plan defaults
| - OK _! Cancal piply
| —

3 - 4 Power Plans



Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High performance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-

ered.

Click to Show/Hide
additional
power plans

"# » Control Panel » All Control Panel tems » Power Options

Select a power plan
Power p
plan acti

Plans shy

own on the battery meter

@ Balanced (recommended)

Automatically balances perfarmance with energy consumgtion on capabile harchware

ing your computer’s performance wheee possible

Sereen biightness: @

Power Management

Figure3- 2
Power Plans (Win 7)

Power Plans 3 - 5



Power Management

Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Win 7 uses the Sleep, Hiber nate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occursthe system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. Y ou should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Switch user

Default Program Log off

Lock

Help and Suppo

Restart

e N Sleep

4
(Shut down Hibeknate

Power-Saving States 3 - 7

Power Management

Figure3-3
Start Menu Power
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4

Password
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-4
Power Options
Define Power
Buttons

Configuring the Power Buttons

The power/deep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttonsdo on
the left menu in Power Optionsto bring up the menu.

:j <« Power Options P System Settings v |43 [l Search Control Panel P

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans.

Power and sleep buttons and lid settings

] On battery 2% Plugged in
@ When I press the power button: [Sleep 'J [Sleep 'I
Do nothing
(B wnen tpress e siep burton
h Hibernate

p- Shut down
f__; When I close the lid |Steep

Password protection on wakeup
<5 Change settings that are currently unavailable
(@ Require a password (recommended)

When your computer wakes from sleep, no one can access your data without entering the correct
password to unlock the computer. Create or change your user account password

Don't require a password
When your computer wakes from sleep, anyone can access your data because the computer isn't
locked.

Save changes Cancel
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Resuming Operation

Y ou can resume operation from power-saving states by pressing the power button,

or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status

lcon /¢y Color

To Resume

Orange (AC/DC adapter)

Power Off Off Press the Power Button
Press the Power Button
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9

Power Management

4

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table3-1
Resuming
Operation
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Power Conservation Modes
el This system supports Energy Star power management features that place comput-
Power Conservation ers (CPU, hard drive, etc.) into alow-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting 1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
will result in maximum & 2 Click either the Performance, Balanced or Energy Star button.
power saving, but with 3. Click in a blank area of the icon or press a key on the keyboard to exit Power

the possible loss of Conservation Mode without making any changes.
some performance.

Setting the mode to Bal- _
ance will give power @ % f-[[-’ﬁﬁ Q. “ g

saving matched with
pel’formance. PowerSaving Flight Entertainment Cuiet Pedomance @) UserDefine

- Y
[ EERSU ) O —
. b
|
-
e [
Sleep Button  Display Switch  Time Zone

DB

Wireless Bluetooth

Performance will give
optimum computer per-
formance but with less
power conservation.

Desttop
Backaground

Power
Conservation

Figure3-5 —
Control Center ‘q
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power

Y our computer’ s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. Y ou can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3-1o0n page 3 - 4).

Click the battery icon [ [0 in the notification areato see the current battery level and
charge status.

|

@ 81% remaining

Select a power plan:

@ Balanced

() Power saver

# Desklop background settings
i Wireless Adapter Settings

+ Sleep

# LSS settings

Adjust screen brightness
Mare power options

& Pt buittans and lil
Bewtore plan defaults

Cancel

Power Management

Low Battery
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure3-6
Battery Icon
(Notification Area) &
Battery Advanced
Settings
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Conserving Battery Power

4 * Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center » Lower the brightness level of the LCD display. The system will decrease LCD
The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

Center control panel

provides an easy point | * Reducethe amount of time before the display is turned off.

of access forinformation § o  C|osewireless, Bluetooth, modem or communication applications when they are
on battery status, power not be|n U%d
plans used and wireless 9 ’

device status etc. » Disconnect/remove any unnecessary external devices e.g. USB devices.

E:;:tiess @ [ Mute [S 13% remaining !!ﬁ! Connected

Brightness Velume Wireless Metwork

Battery Status
No display No sync g .
Figure 3 _ 7 L‘-—‘ connected @ partnerships NP R i
Windows Mobility =] [ m—e— 1 =
Connect display Sync settings urn on
Center
External Display Sync Center Presentation Settings
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see“ Removing the Battery”
on page6 - 4.

New Battery

Always completely discharge, then fully charge, anew battery (see“ Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. (Refer to“ LED Indica-
tors’ on page 1 - 7 for information on the battery charge status, and to “ Battery I n-
formation” on page 3 - 11 for more information on how to maintain and properly
recharge the battery pack.)

.|
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Proper handling of the Battery Pack

2§ « DO NOT disassemble the battery pack under any circumstances.
* DO NOT expose the battery to fire or high temperatures, it may explode.

e DO NOT connect the metal terminals (+, -) to each other.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the Damaged Battery Warning
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

"# = Power Options + Edit Plan Settings x| 43 ) Sewrch Control Panel g2

Change settings for the plan: Discharge Battery

Choose the sleep and display settings that you want your computer to use.

i On battery % Plugged in
2 Dim the display: MNever = |Never X -
Figure3-8
D Tum off the dispiay. Never | Never ki POWerg Plan Create
W Put the computer to sleep: | Never *| |Never -
Adjust plan brightness: " =
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

“F = Al Control Panel e & Power Options = e | Sescen Covdrat Parel o)
— —

Figure3-9
Change Plan
Settings / Change
Advanced Power
Settings

.|
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

r — = o
55 Power Options ", L0 ]| [45 power Options "EG—_. - [0 [
Advanced seftings Advanced settings
3z Select the power plan that you want to customize, 3 Select the power plan that you want to customize,
; and then choose settings that reflect how you want ; and then choose settings that reflect how you want
your computer to manage power, your computer to manage power.
% Change settings that are currently unavailable ¥ Change settings that are currently unavailable
|Discharge Battery [Active] - |Discharge Battery [Active] =
# Multimedia settings ~ Plugged in: 5% &
= Battery [ Low battery notification
=l Critical battery action On battery: Off
On battery: Shut down Plugged in: Off

Plugged in: Do nothing El Low battery action Fl gure 3 - 10
= Low battery level .
Power Options

L

On battery (%): _ = Plugged in: Do nothing

Plugged in: 0% = Reserve battery level ‘E H _
[= Critical battery level On battery: 0% i Advan Ced Settl n g S
. On harhc-r;;'! 59 . i o DPhunned in: ne. ) n E Battery
Restore plan defaults Restore plan defaults
[ ok [ cancet || appy [ ok ][ cancel || appy

* Low battery levels= 0%

» Critical battery Levels= 1%

* Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4. Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most avail able op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

The Device Drivers & Utilities + User’s Manual disc contains the drivers and utili-
ties necessary for the proper operation of the computer. Table 4 - 1, on page 4 - 3
listswhat you need toinstall and it isvery important that thedriversareinstalled
in the order indicated.

Module Driver Installation

The proceduresfor installing driversfor the PC Camera, WLAN and Combination
Bluetooth & WL AN modules (you should also install the THX Studio Pro Audio
and Intel Rapid Storage Technology drivers asinstructed in Chapter 7) are provid-
edin“Modules’ on page 7 - 1.

. |
What to Install 4 - 1

Drivers & Utilities

\ 7/
2§
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).




Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities+ User’s Manual
disc and click I nstall Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

-
i) Drivers Installer

/2 '_'M_ob_l_le LG!_~-.HM(M’*‘ ¥

Figure4 - 1- Drivers Installer Screen 1

Note: If you need to reinstall any driver, you should uninstall the
driver first.

1. Check the driver installation order from Table 4 - 1,

on page 4 - 3 (the drivers must be installed in
this order) which is the same as that listed in the
Drivers Installer menu below.

2. Click to select the driver you wish to install, (you

should note down the drivers as you install them).

3. Follow the instructions for each individual driver

installation procedure as listed on the following
pages.

-
Q) Drivers Installer
%

= T'Nlobi.le Cél_'i'iﬂlltin“_ '*ﬂ“

=

Please follow steps from top to bottom in order to install drivers.

Figure4 - 2 - Drivers Installer Screen 2

4 - 2 Driver Installation



Drivers & Utilities

Windows 7 SP1 Driver Page Windows 7 SP1 Driver Page
Chipset Page 4 - 6 Setting Up SATA RAID or AHCI Mode Page 7 - 2
Video (VGA) Page 4 -6 PC Camera Module Page 7 - 15
NVIDIA Video (VGA) Page4-6 Wireless LAN Module Page 7 - 23
LAN Page 4 -6 Intel® Wireless Display Application Page 7 - 44
Card Reader Page 4 -7 Bluetooth Module Page 7 - 49
TouchPad Page 4 -7 THX TruStudio Pro Audio Page 7 - 56
Hot Key Pag4-7 | (Cequiredfor hrd digks n AHCI mode) Page 7- 61
USB 3.0 Page4 -7 Intel® Rapid Start Technology Driver Page 7 - 66
MEI Driver Page 4 -7
Audio Page 4 -7

Table4 - 1 - Driver Installation

Note all drivers provided are for Windows 7 with Service Pack 1.

Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.
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Manual Driver Installation

Click the Browse CD/DVD button in the Drivers In-
staller application and browse to the executablefilein
the appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updates etc. (all updateswill includethe latest hotfixes
from Microsoft). See “ Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+" to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue thein-
stallation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

Driver Installation 4 - 5
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button), or Option Driv-

ers (button) to access the Optional driver menu.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chap-
ter (and in Chapter 7 Options & Modules), are accu-
rate at the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Chipset

1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

NVIDIA Video (VGA)

1
2.

3.
4.

Click 3.Install NVIDIA VGA Driver > Yes.
Click AGREE AND CONTINUE (button) to
accept the terms of the license agreement.
Click Next > Next.

Click the RESTART NOW button to restart
the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 settings to the highest resolution.

LAN

1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.

3. Click Finish.
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Card Reader

1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.

TouchPad

1. Click 6.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license, and then
click Next.

4. Click Finish > Restart Now to restart the com-
puter.

Hot Key

1. Click 7.Install Hotkey AP > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart your computer.

USB 3.0

1. Click 8.Install USB 3.0 Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Drivers & Utilities

MEI Driver

1. Click 9.Install MEI Driver > Yes.
2. Click Next > Yes> Next.
3. Click Finish.

Audio

1. Click 10. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

After installing the audio driver the system will not re-
turn to the Drivers Installer screen. To install any of
the optional drivers, gject the Device Drivers & Utili-
ties+ User’s Manual disc and then reinsert it (or dou-
ble-click the disc icon in My Computer), and click
Option Drivers (button) to access the optional driver
menu.

It is recommended that you install the THX Tru Stu-
dio Pro Audio application for maximum audio perfor-
mance (see “THX TruStudio AP Installation” on
page 7 - 56) and Intel Rapid Storage Technology
driver (see “Intel® Rapid Storage Technology Driv-
er” on page 7 - 61 - required for AHCI mode).
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4
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Click Windows Update (System and Security/
Security).

3. Click Check for updates (button).

4. The computer will now check for updates (you
need to be connected to the internet).

5. Click Install now (button) to begin checking for the
updates.

6. Click Install updates (button) to install the
updates.

Windows Experience Index

After Video (VGA) driver has been installed, and the
system restarted, the OS will automatically run the
"Winsat.exe" to rate the performance. If you have re-
started the system during this time then follow the in-
structions below to update the information.

After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence I ndex (make sure the AC/DC adapter is plugged

in):

1
2.

Click Sart, and click Control Panel.

Click Performance Information and Tools
(System and Security > System > Check the
Windows Experience I ndex).

Click “Rate this computer/Refresh Now/Re-
run the assessment”.

The computer will take afew minutes to assess
the system performance.

Close the control panel.
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Optional Drivers

See the pagesindicated in Table 4 - 1, on page 4 - 3 for the driver installation procedures for any modules in-
cluded in your purchase option.

(% Driverc Tistatter [
: "'i\/iobije (/01__'; iputin

N

Please follow steps from top to bottom in order to install Option drivers.

Figure 4 - 3 - Optional Drivers Installer Screen
Note that you need to install both the WLAN & Bluetooth driversfor all the Bluetooth Combo modules.
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BIOS Utilities

Chapter 5: BIOS Utilities ¢

/ \Y

BIOS Screens

Overview
. . L . - Note that the BIOS
This chapter gives a brief introduction to the computer’ s built-in software: scor:ens - pictufed on
these pages are intend-
Diagnostics: The POST (Power-On Self Test) ed for guidance in set-

ting up your system'’s
BIOS.

Configuration: The Setup utility
If your computer has never been set up, or you are making important changestothe B =ee e e o
system (e.g. hard disk setup), then you should review this chapter first and note the BT ERee S EREETRE
original settings found in Setup. Even if you are abeginner, keep arecord of the set- | EUCEUEICIIGEE S
tings you find and any changes you make. This information could be useful if your At EE S
- screens may appear
System ever needs servicing. slightly different from
those pictured on these

There is one genera rule: Don’t make any changes unless you are sure of what you  JeElkss
aredoing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service

representative.

. |
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The Power-On Self Test (POST)

If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you
turn on the computer the system takes afew seconds to conduct a POST, including
aquick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that preventsthe system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot op-
tions.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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The Setup Utility

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

BIOS Settings
Warning

Incorrect settings can Entering Setup

cause your system to .
malfunction. To correct To enter Setup, turn on the computer and press F2 (give the system a few seconds

el e o B to enter Setup; the F2 on screen will be highlighted to illustrate that the system is
LR ESERGEEEl  processing the request) during the POST (or press F7 for boot options). If you get a

VRS EEEE R “ K eyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.
<F2>, or Optimized De-

faults with <F3>. . . N

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and

then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7.

.|
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the Z

top of the screen is a menu bar with menu headings. When you select a heading, a Setup Menus
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

The Setup menus
shown in this section are

Instructions on how to navigate each screen arein the box at the bottom right side of || for reference only. Your
the screen computer's menus will

indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keys to scroll up or down the page.

Theltem Specific Help on the upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has asimilar layout, but the Enter key may
execute a command.
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Figure5-2
Main Menu

5 - 6 Main Menu

Main Menu

Aptic Setup Utility — Copyright (C) 2011 American Megatrends Inc.

System Date:

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

Systerm/Extended Memory (Main Menu)
Thisitem containsinformation on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOSRevision / KBC/EC Firmware Revision (Main Menu)
This item contains information on the BIOS version and video card etc., and is not
user configurable.

. |
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Advanced Menu

Aptic Setup Utility — Copyright (C) 2011 American Megatrends Inc.

Figure5- 3
Advanced Menu

P Bdvanced Chipset Control

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to adjust the Bluetooth Power Setting .
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Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)

Y ou can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

Intel(R) Rapid Start Technology (Advanced Menu)

Enable/disable Intel(R) Rapid Start Technology from this menu. The rapid start
hibernation mode can resume power within 5 to 6 seconds and can remember your
computer's state with zero power.

Intel Anti-Theft Technology (Advanced Menu )

Anti-Theft Technology, which is built-in to the processor of the computer, allows
system administrators to render your computer useless to thieves by sending a poi-
son pillencrypted SM S message over a 3G network etc. Administrators can also re-
motely unlock a recovered computer quickly, or direct the system to send location
information (GPS coordinates) back to a central server.

. |
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SATA Mode
Selection

If you have installed the
Windows 7 operating
system with either IDE,

AHCI or RAID mode en-
abled, DO NOT disable
the set mode (if you wish
to disable the set mode
you will need to reinstall
the Windows 7 OS).

SATA Mode (Advanced Menu)

Y ou can configure SATA (Serial ATA) control to operate in | DE (native/compati-
ble), AHCI (Advanced Host Controller Interface) or RAID (Redundant Array of In-
dependent disks) modes from this menu. The SATA M ode should be set BEFORE
installing an oper ating system, and after you have backed up all necessary filesand
data (see sidebar). See “ Setting Up SATA RAID or AHCI Mode” on page 7 - 2 for
details. Make sure you install the Intel Rapid Storage Technology application if
you have set the SATA Mode to RAID or AHCI “Intel® Rapid Storage Technol-
ogy Driver” on page 7 - 61.

Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Aptio Setup Utility — Copyright (C) 2011 American Megatrends Inc.

4

Security Menu

Security

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Set Supervisor Password

Figure5-4
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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NG
A&

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled”), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not apassword should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“ Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.
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Boot Menu

Aptio Setup Utility — Copyright (C) 2011 American Megatrends Inc.

Boot .
Figure5-5
Boot Menu

Boot Option #1 [P2: MATSHITABD-CMBE. .. ]

SN
ZAS

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

S . your computer's actual
When you turn the computer on it will look for an operating system (e.g. Windows R

7) from the devices listed in this menu, and in this priority order. If it cannot find  EESFERRIENHAE AR
the operating system on that device, it will try to load it from the next device in the B QEEE ORI R NG
order specified in the Boot Option Priorities. Item specific help on the right is JEEEES

available to help you move devices up and down the order.
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Boot Option Priorities (Boot Menu)
Use the arrow keys to move up and down the menu and press Enter, then select the

iteminthe Boot Option # using the arrow keys, and press Enter again to set theitem
as the appropriate boot priority. You can go to either Network Device BBS Priori-
ties, CD/DVD ROM Drive BBSPrioritiesor Hard Drive BBS Prioritiesand use
the + and - keys to move any device's boot priority up and down the list (the se-
lected device will be highlighted in white).
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Exit Menu

Aptio Setup Utility — Copyright (C) 2011 American Megatrends Inc.

Figure5-6
Exit Menu

Exit

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to itsoriginal state, and erase any previous changes you have madein
aprevious session.

. |
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Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problemsyou can con-
tact your service representative for further help. Before you begin you will need:

» A small crosshead or Phillips screwdriver
* A small regular slotted (flathead) screwdriver
e Anantistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

* Removing the Component Bay Cover

» Upgrading the Hard Disk Drive(s)

* Removing the Optical Device Drive

» Upgrading the System Memory (RAM)

Please make surethat you review each procedure before you perform it.

NG
L&

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
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When Not to Upgrade
\ A/
2§ These procedures involve opening the system’s case, adding and sometimes replac-
Power Safety Warning ing parts.Y ou should not perform any of these upgrades if:

SO EEERE S ¢ Your system is till under warranty or aservice contract
any upgrade proce-

Sl e SR ¢ You don't have all the necessary equipment

you have turned off the ¢ You're not in the correct environment

power, and disconnect-  You doubt your abilities

ed all peripherals and

LIS EEREESE - Under any of these conditions, contact your service representative to purchase or re-
B e, place the component(s).

You must also remove
your battery in order to
prevent accidentally
turning the machine on.
Before removing the
battery disconnect the
AC/DC adapter from
the computer .

2N
Ik

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
e Keep away from moving fan blades.

. |
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Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with afast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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NG
A&

Warranty Warning

Please check with your
service representative

before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure6-1
Battery Removal

Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery. Before removing the battery disconnect the AC/
DC adapter from the computer first.

1.

2.
3.
4

Turn the computer off, remove the AC/DC adapter and turn it over.

Slide the latch @ in the direction of the arrow.

Slide the latch @ in the direction of the arrow and the battery will pop up.
Lift the battery @) out of the compartment.
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Removing the Component Bay Cover

Turn off the computer, and turn it over and remove the battery.

Locate the component bay cover and remove screws 0 - 6

Slide the cover in the direction of arrow @), until the case markers @ line up.
Remove the component bay cover @

PonNPE

Figure6 - 2
Component Bay
Cover Removal
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Replacing the Component Bay Cover

1. Reinsert the component bay cover by placing it on the bottom case assembly and
sliding it on to the case in the direction of arrow @.

2. Make sure the case markers @ line up.

3. Replace screws 0 - Q (Figure 6 - 2 on page 6 - 5).

Figure6-3

Component Bay

b Cover Replacement
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Upgrading the Hard Disk Drive(s)

\ A/
The hard disk Drive(s) can be taken out to accommodate up to two other 2.5" serial ’Ll\
(SATA) hard disk driveswith a height of 9.5mm (h) (see“ Storage” on page D - 4). B =i BRI ERINTY
Follow your operating system’s installation instructions, and install all necessary BENEEEEoE 1o R0 e =
driversand utilities (asoutlined in“ Drivers & Utilities’” on page 4 - 1), when setting | ISICREERERPERCETIES

. You have backed up any
up anew hard disk. data you want to keep from

your old HDD.

You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

.|
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Removing the Hard Disk from the Primary HDD Bay
1. Turn off the computer, and turn it over and remove the battery (see page 6 - 4).

2. Remove screw @.
3. Slide the HDD cover in the direction of arrow @ until the case markers line up.
4.

Lift the HDD cover out of the computer @.

Figure6- 4
Primary HDD Cover
Removal
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Slide the hard disk assembly @ forward, and remove the assembly from the

computer. ﬁ
Remove screws @ & @ and the primary HDD insulation plate @. .

Reverse the process to install a new disk and do not forget to reinstall the HDD Insulation Plates
insulation plate. Note that the HDD insu-

Replace the component bay cover (see page 6 - 6). lation plates for the pri-

mary and secondary
hard disks, though simi-
lar in outward appear-
ance, are NOT

interchangeable. The
plates are clearly
marked 1ST HDD & 2nd
HDD.

Make sure you use the
appropriate  insulation
plate for the HDD as the
sizes are slightly differ-
ent

Figure6-5
Primary Hard Disk
Insulation Plate
Removal
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Removing the Hard Disk from the Secondary HDD Bay
\ A/

;Q; 1. Turn off the computer, and turn it over and remove the battery and component bay
cover (see pages 6 -4 & 6 - 5).

Remove screws @ & @ from the secondary HDD assembly.

Note that the HDD insu- 3. Slide the HDD assembly in the direction of arrow €.

lation plates for the pri- 4. Lift the HDD assembly out of the computer @.

mary and secondary
hard disks, though simi-
lar in outward appear-
ance, are NOT
interchangeable.  The
plates are clearly
marked 1ST HDD & 2nd
HDD.

HDD Insulation Plates 2

EETTTTTIIIT « Ao

Make sure you use the
appropriate  insulation
plate for the HDD as the
sizes are slightly differ-
ent

e =, T )

Figure6- 6
Secondary HDD
Assembly Screws &
Removal
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5. Remove screws @ & @ and separate the case bracket @) and the insulation

plate @.

Figure6-7
Secondary
Hard Disk Case
Bracket & Insulation
Plate Removal

6. Reverse the process to install a new disk (pay careful attention to the orientation of
the hard disk in the case bracket before tightening the screws).

7. Insert the new HDD into the case along with the insulation plate and replace the
crews.

8. Reinsert the HDD assembly back into the case and replace the screws @ & @
(Figure 6 - 6 on page 6 - 10).

9. Replace the component bay cover (see page 6 - 6).
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Removing the Optical Device Drive

1. Turn off the computer, and turn it over and remove the battery and component bay
cover (see pages 6 -4 &6 - 5).

2. Remove the screw at point 0 and use a screwdriver to carefully push out the
optical device at point @.

Figure6- 8
Removing the
Optical Device

3. Reverse the process to install the new device.
4. Replace the component bay cover (see page 6 - 6).
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDR 111 (DDRS3) type memory modules (see “Memory” on pageD - 3).
The total memory size is automatically detected by the POST routine once you turn
on your computer.

Notethat three SO-DIMMsareonly supported by Quad-Core CPUs; Dual-Core
CPUs support two SO-DIMMs maximum (see “Memory” on page D - 3 for full
details).

Two primary memory socketsar elocated under component bay cover (the bot-
tom case cover), and secondary memory socket islocated under the keyboard
(and isnot user upgradable). If you areinstalling only two RAM modulesthen
they should beinstalled in the primary memory sockets under the component
bay cover.

Note that the RAM located under the keyboard is not user upgradable. Contact your
service center for more information if you wish to upgrade the memory in the sec-
ondary memory sockets.

.|
Upgrading the System Memory (RAM) 6 - 13



Upgrading The Computer

1. Turn off the computer, and turn it over and remove the battery and component bay
cover (see pages 6 -4 &6 - 5).
2. The memory sockets will be visible at point @ on the mainboard.
Figure6-9
RAM Module
Location

&

Contact Warning

Be careful not to touch
the metal pins on the

module’s connecting
SCCERSE R EEEERESER 3. Gently pull the two release latches (@) & @) on the sides of the memory sockets)

hands have oils which in the direction indicated below.
can attract particles, and

degrade the module’s
performance.

0h.8r800 8 1e
RN |
L 080INEDEYEONH
Figure 6-10 nn:rlm:rw‘:zsa!:m-cuua.@
RAM Module
Release Latches
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4. The RAM module will @) pop-up, and you can remove it.

4

- . 1 o Figure 6-11
Single Memory Module 4 v RAM Module
Installation : Removal

If your computer has a single memory
module, then insert the module into the

Channel 0 (JDIMM1) socket. In this
case this is the lower memory socket
(the socket closest to the mainboard).

SN
A&

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

5. Pull the latches to release the second module if necessary.

6. Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory socket.

7. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the socket as it will go. DO NOT FORCE the module; it should
fit without much pressure.

8. Press the module in and down towards the mainboard until the socket levers click
into place to secure the module.

9. Replace the component bay cover (see page 6 - 6).

.|
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Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

» Setting Up SATA RAID or AHCI Mode
PC CameraModule

WirelessLAN Module

Intel® Wireless Display Application
Bluetooth Module

THX TruStudio Pro Audio

Intel® Rapid Storage Technology Driver
* Intel® Rapid Start Technology Driver

. |
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RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

SATA Mode
Selection

The SATA mode selec-
tion should be made be-
fore installing your
operating system.

DO NOT change your
selected SATA mode
unless you intend to re-
install your operating
system. Make sure you
have backed up all your
data before doing so.

Setting Up SATA RAID or AHCI Mode

AHCI Mode

Advanced Host Controller Interface (AHCI) isan interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one or two hard disks. Make sureyou install the I ntel® Rapid Storage
Technology application if you have set up your hard disk(s) in AHCI mode (see
“Intel Rapid Storage Technology” on page 7 - 9)

RAID

To configure your RAID (Redundant Array of Independent Disks) system in Strip-
ing (RAID 0), Mirroring (RAID 1) or Recovery modes (see Table 7 - 1, on page 7 -
3) you will require at least two identical (see sidebar) hard disks. Note that if you
areusing Advanced format hard disksthat have a 4K B physical sector size, and
you are installing aWindows 7 release pre Service Pack 1, you will need to install
adriver fromthe Device Drivers & Utilities+ User’sManual disc at OSinstallation
(see page 8 - 20).

Intel® Rapid Storage Technology Application

Make sure you install the Intel® Rapid Storage Technology application if you
have set up your hard disk(s) in RAID mode (see “ Intel Rapid Storage Technolo-

gy’ onpage7-9).

7 - 2 Setting Up SATA RAID or AHCI Mode



RAID Level Description

Identical drives reading and writing data in parallel to increase performance. RAID 0
RAID 0 implements a striped disk array and the data is broken into blocks and each block is
written to a separate disk drive.

Identical drives in a mirrored configuration used to protect data. Should a drive that is
part of a mirrored array fail, the mirrored drive (which contains identical data) will

RAID 1 handle all the data. When a new replacement drive is installed, data to the new drive is
rebuilt from the mirrored drive to restore fault tolerance.
Two Identical drives copying data between a master and a recovery disk. This provides
Recovery more control over how data is copied between the master and recovery drives, fast

volume updates and the ability to view the data in Windows Explorer.

2N
&

SATA Mode Selection

The SATA mode selection should be made before installing your operating system.

DO NOT change your selected SATA mode unless you intend to reinstall your operating
system. Make sure you have backed up all your data before doing so.

Modules

Table7-1
RAID Levels

4

Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A  Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the 1/O load
across the channels
and drives.
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Prepare the following before setting up your serial ATA hard disksin RAID mode:

1. The Microsoft Windows 7 OS DVD.
2. A hard disk installed in the Primary HDD bay.

AND

A second (identical) hard disk installed in the Secondary HDD bay.
3. The Device Drivers & Utilities + User’s Manual disc.

Notethat if you are using Advanced format hard disksthat have a 4K B physical
sector size, and you areinstalling aWindows 7 release pre Service Pack 1, you will
need to install adriver from the Device Drivers & Utilities+ User’s Manual disc at
OSinstallation (see page 8 - 20).
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SATA RAID Setup Procedure (BIOS)

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Gotothe Advanced menu, select "SATA Mode" and press Enter (see page 5 - 9).

Select “RAID Mode”.

3. Press Esc and go to the Boot menu.

4. Set the DVD-ROM Drive (make sure the Microsoft Windows 7 OS DVD is
inserted) as the first device in the boot order from the Boot menu (see “Boot
Menu” on page 5 - 13).

5. Select Save Changes and Exit from the Exit menu (or press F4 and Enter) and
press Enter to exit the BIOS and reboot the computer.

6. See the instructions in “RAID Setup (Intel Matrix)” on page 7 - 6.

.|
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RAID Setup (Intel Matrix)
1. Asthe computer starts up press Ctrl + i to enter RAID configuration menu.

Figure 7-1 Intel (R) Rapid Storage Technology - Option ROM - XX.X.X.XXXX
. Copyright (C) 2003-11 Intel Corporation. All Rights Reserved.
Intel(R) Rapid

Storage Technology [ l

: 4.  Recovery Volume Options
Opt|0n ROM 2. Delete RAID Volume 5. Acceleration Opticns

3. Reset Disks to Non-RAID 6. Exit
[ 1

RAID Volumes:
Hone Defined

/ Physical Devices:

Port Drive Model Serial # Size Type/Status(Vel ID)
Recovery Level 1 TOSHIBA MK2565GS X07STIMYT 232.8GB
2 TOSHIBA MK2565GS XKO07ST1NOT G

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

[T ]-Select [ESC]-Exit [ENTER] -Select

You can select the syn- 2. Select 1.Create RAID Volume and press Enter.

chronization  between 3. Type the RAID volume name and then press Tab or Enter to advance to the next

the disks to be Continu- field.

ous (automatic) or On 4. Specify (use the up and down arrow keys) the RAID level (RAID 0, RAID 1 or

Request (manually). Recovery - see Table 7 - 1, on page 7 - 3) and then press Tab or Enter to
advance to the next field.
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5. Press Enter and the system will select the physical disks to use (see sidebar for

Recovery Level). 4
Press Enter and select (if applicable) the Strip Size (best set to default).
Press Enter and select the Capacity size (best set to default). Recovery Level

Press Enter to select Create Volume.
Press Enter to create the volume, and confirm the selection by pressing Y.
10. This will now return to the main menu.

When selecting disks for
the Recovery RAID level
you will need to use the
Intel (R) Rapid Storage Technology - Option ROM - XX.X.X.XXXX Tab key to select a Mas-
Copyright (C) 2003-11 Intel Corporation. All Rights Reserved. ter disk’ and the Space

[ key to select a Recov-

. Recovery Volume Options ery disk.

2. Delete RAID Volume » Acceleration Options

3. Reset Disks to Non-RAID . i
¢ You can select the syn-

. chronization  between
RAID Volumes: - -
$h Nana el the disks to be_Contlnu-
0  MyRAID Recovery(Cont.) N/ 232.9GB s ous (automatic) or On
Request (manually).

6
7.
8.
9.

FPhysical Devices:

Port Drive Model Serial # i Type/Status (Vol ID)
1 TOSHIBA MK2565GS XO07STIMYT G

2 TOSHIBA MK2565GS X07STINOT

Figure7-2
RAID Created

[T ] -Select [ESC]-Exit [ENTER] -Select

11. Select 6.Exit and press Enter, then press Y to exit the RAID configuration menu.
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12. Make sure the Windows 7 OS DVD is in the DVD drive. and as the computer

/ starts up it will automatically boot from the Windows 7 OS DVD (you will be
prompted to press a key to boot from the DVD).
Win7 (pre SP1) & 13. Press Enter to continue installing the operating system as normal (see your
Advanced Format Windows documentation if you need help on installing the Windows OS - see
Disks in a RAID Sidebar)_

14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Rapid
Storage Technology driver - see “IRST Driver Installation” on page 7 - 9).

Note that if you are in-
stalling a Windows 7
OS pre Service Pack 1,
and you are using Ad-

vanced format hard
disks that have a 4KB
physical sector size,
you will need to install a
driver from the Device
Drivers & Utilities +
User’'s Manual disc at
OS installation (see
page 8 - 20).

.|
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Intel Rapid Storage Technology

The Intel Rapid Storage Technology application provides high-performance
SATA and SATA RAID capabilities. Install the Intel Rapid Storage Technology
application (after installing all necessary drivers in the correct order) to support
your RAID system or SATA driveif set upin AHCI modeintheBIOS (see” SATA
Mode (Advanced Menu)” on page5 - 9).

IRST Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 8.Install IRST Driver > Yes.

Click Next > Next > Yes> Next > Next.

Click Finish to restart the computer (you will need to restart the system
again after the computer has rebooted).

alrwpn

See the following pages for more information if you have set your hard disksup in
aRAID configuration.

.|
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Intel® Rapid Storage Technology for RAID Systems

Intel® Rapid Storage Technology application displays status information on your
RAID configuration. Run the I ntel® Rapid Storage Technology application from

the Intel item in the All Programs menu.

When the Intel® Rapid Storage Technology application is launched the system
will open the Status window.Here you can view the general health of the storage
system. Various volume creation and management options are avail able depending

on the system’ s status.

4 Intel® Rapad Storage Tochrology —ron |
intel)
Figure7-3 — o
Intel® Rapid .
Storage Technology o ]
Status g— |

.|
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Intel® Rapid Storage Technology Help
If ahard drive member of aRAID volumeis reported as“Degraded” or “Failed” it 4
may be possible to recover the volume. If the volume cannot be restored then you

will need to recreate the RAID volume and restore the datafrom aback up. Click the Help
Help menu (or press F1) for instructions on how to recover or recreate RAID Vol- Click the Help (or press
umes. F1) menu button at the

top of the Intel® Rapid
2 Inel® Ragid g Technclogy Help _ == o8 Storage Technology

‘:j| 1\] 5 I & | application.

iiiii

Gnllne Suppent Abodt

Click Contents to view

the general list of sub-
jects covered, click In-
dex or Search for a
more specific help top-
ics on a particular item.

Intreduction

Click More help on this
page at the bottom of
any page for page spe-
cific help.

Eesss
F

Figure7-4
Intel® Rapid
Storage
Technology
Help
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Table7-2
RAID Level
Verification &
Repair Status

RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad
dataon aRAID 0 or RAID 1 volume. Thetable outlines what occursfor each RAID

level:
RAID . . .
Verif Verif Repair
Level enty S & REpE
RAID 0 Bad blocks are identified. N/A
Bad blocks are reassigned.
Bad blocks are identified. If the data on the mirrored drive does not
RAID 1 Data on the mirrored drive is compared to match the data on the source drive, the
data on the source drive. data on the mirrored drive is overwritten by
the data on the source.

Replacing and Reverting Recovery and Master Volumes

If amaster or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can aso revert the master drive to the
state of the previous volume update. For details on how to do this see the help file
“Intel® Rapid Storage Technology Help” on page 7 - 11.

See over for details on how to verify and repair RAID volumedata. Verification will
identify and repair datainconsistencies on the volume.
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Verifying and Repairing RAID Volume Data

1. Before verifying the volume data you will need to initialize the volume.

2. Runthe Intel® Rapid Storage Technology application from the Intel item in the
Programs/All Programs menu.

3. Click Manage and click Advanced.

4. Click Initialize and click Yes (button) to begin the process.

5. The completion percentage will be listed under Status.

"@ Intel® Rapid Sterage Technelogy [o | = |z
] i
: ~J @ (l@
' Manage Preferences Help .

Figure7-5
Manage Volume Storage System View ()] Intel@ Rapld

Name: MyRAID Rename —— Stor age
| Technology

fa Initialize

Size: 152,625 MB

Update mode: Continuous Change mode

‘Write-back cache: Disabled Enable ’_"

System volumes
Initializea:
Verification details Verify
Verification E'ruq Initialize to enable the verification and repair of data incensistencies on the volume.
Blocks with media errors: 0 | ‘e‘_ External empty port 1
Physical sector size: 512 Bytes [VRmETRIEER
Logical sector size: 512 Bytes

| % ™ Internal ATAZ] device

e you sure you want b initialize this volume new?

(0 This peocess coutd take & while depending an the numbar bnd size of the ditks, Yo £an continue uting

valume data and ather apphications daing this time.

Moare help on this page
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6. Click Advanced and click Verify, then click Verify (button) to begin the process.
7. The completion percentage will be listed under Status (verifying and repairing).

W 5|0 (inteD)

Status | Manage Preferences Help

Manage Volume Storage System View @
Name: MyRAID Rename

Array_0000

Status: Normal

Type: Recovery Change type

fi.o’

Fi gure 7-6 Size: 152,625 M3 MyRAID
. Type: Recovery
Intel® Rapld ¥ Advanced 143G8
Update mode: Continuous Change mode
Stor age Write-back cache: Disabled Enable ()
TechnO|Ogy System volume: Yes

Initialized: Yes

. ~ i
Verlfy I deta |-,l % Internal ATA?I device ]

Verification errors F—— m x = z
5 5 | Verify and repair data inconsistencies on the volume. b
Blocks with media - External empty port 1

Physical secter sjm

Logical sector si; @ Verify Volume Data M

Swiap master an

Keep your data healthy by identifying and repairing data inconsistencies on your volume.

Automatically repair errors fthis page

Maore help Cancel I
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PC Camera Module

Before installing the driver, make sure the PC Cameraison. Usethe Fn + F10 key
combination, or Control Center button, to toggle power to the to the PC Cameramod-

ule. Make sureyou install the driversin the order indicated in Table 4 - 1, on page 4
- 3. Check the Device Drivers
& Utilities + User’s Manu-
al disc and any accompa-

There are anumber of different cameramodul es avail able with this computer model nying insert pages, for the

H H ; H H ; latest updated information
series. You will have the appropriate application installed for your camera. Make T S

Latest PC Camera
Driver Information

sure you access the application via the desktop shortcut. which may override the in-

2NZ
2 &

PC Camera Application and Power-Saving States

formation provided here.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

If the computer enters Sleep or Hibernate mode while running the camera application, the
program will stop running, and will need to be restarted when the system resumes from the
power-saving state.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).

. |
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PC Camera Driver Installation

1

aroN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.

Click Option Drivers (button).

Click 1.Install Webcam Driver > Yes.

Click Finish to restart the computer.

Run the camera application program from the desktop shortcut (if the hard-
ware isturned off use the Fn + F10 key combination, Control Center button

or camera hot key button (o] to turn it on again).

. |
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PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Sound *# (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is
not disabled.

5. Double-click Microphone (or select Properties from the right-click menu).

6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

7. Click OK and close the control panels.

8. Run the camera application program from the desktop shortcut.

9. Go tothe Devices menu heading and select Microphone (Realtek....) (it should
have a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

11. To obtain the best sound recording quality enable Noise Suppression in the
Realtek HD Audio Manager control panel (see “ Setup for Audio Recording” on
page 2 - 8).
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Figure7-7
Audio Setup for PC
Camera

| Playback | Recording |Sounds | Communications |

Select a recording device below to modify its settings:

"":_ Microphone
N Realtek High Qefinition Audi

i) Default Devi

Right-click

Configure Speech Recognition

Disable

Show Disabled Devices

Show Disconnected Devices

Properties

| Set Default ||
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Microphaone
oL 74
Microphaone Boost
[ 7U | +30.0 dB
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I Capture | Help

Start Capture
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Set Time Limit...
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Camera Application
The cameraapplicationisavideo viewer for general purpose video viewing and test-
ing, and for capturing video filesto .avi format.

1. Runthe camera application from the desktop shortcut (it is recommended that you
set the capture file before the capture process - see below).

2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page 7 - 17) and select Start Capture.

3. Click OK/Yes (the file location will be displayed in the pop-up box) to start
capturing the video, and press Esc to stop the capture (you can view the file using
the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and |ocation before capture (thiswill help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
" Capturefilesize:" and click OK. Y ou can then start the capture process as on the
previous page.

Note theimportant information in “Reducing Video File Size” on page 7 - 20in
order to savefile space, and help prevent system problems.

. |
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires aminimum of 15GB of free space on the C:
drive system partition. In order to prevent system problems it is recommended that
you save the captured video file to alocation other than the C: drive (see“ Set Cap-
ture File” on page 7 - 19), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.

. |
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Eliminating Screen Flicker

. . . . . . \ A/
If you find that the video screen in the camera program is flickering, you can try to ﬂt
adjust the setting in the Video Capture Filter options. Latest PC Camera
1. Run the camera application from the desktop shortcut. DVEEinformation
2. Goto Options and scroll down to select Video Capture Filter.... Check the Device Driv-
3. Click either 50Hz or 60Hz under PowerLine Frequency. ers & Utilities + User’s

Manual disc, and any

accompanying insert
pages, for the latest up-
dated information on the

4

+ Video Froc Amp ?| Camera Control

Auto Camera Options .

Brightness =y = PC Camera driver,
Contrast - 0 = m The video capture filter which may override the

T e = .-; figure pictured here may information  provided

. = appear slightly different here, including the fig-
Saturation i | A

= = for some camera mod- ures pictured here.

Sharpness 1t 5 |

= ules. To adjust the anti

Gamma - il = la flicker properties look un-
iihite Balance ] - 0 der the headings Anti
| O Flicker/Frequency/Pow-

erLine Frequency.

Backlight Comp [f = F 7 8
igure? -
Video Capture Filter

Gairn

Powerline Frequency 60 Hz :
{Anti Flicker)

ColorEnable [

[ ok ][ cancel ] Apply
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Taking Still Pictures
L& The camera application allows you to take still pictures.

Snapshot Folder 1. Run the camera application from the desktop shortcut.

2. Go to Options and select Take Picture.

3. The picture (in JPEG format) will be placed in the Snapshot folder B
desktop.

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you

try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

. |
7 - 22 PC Camera Module



Wireless LAN Module

If you haveincluded an Intel® or 3rd Party WirelessLAN (or WLAN & Bluetooth _ _
combo) modulein your purchase option, make sure that the WLAN moduleison be- nggf;zsn 'if)"c:;f .
foreinstalling the driver. Aircraft

Use the Fn + F11 key combination, Control Center button or WLAN hot key button leitrszc ﬁgniﬁ,sﬁgﬁaﬁ'j
() to toggle power to the Wireless LAN module. Make sure you install the drivers  BRESERREEETE =R TERE
intheorder indicatedin Table 4 - 1, on page 4 - 3. The operating systemisthedefault bR dliEEa T EiE
setting for Wireless LAN control in Windows 7.

the module(s) are OFF if
you are using the computer
aboard aircraft.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN  BEFEEIE S e SR

& Bluetooth Combo modules. bination to toggle power to
the WLAN module, and
check the LED to see if the
module is powered on or
not (see

/

).
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3rd Party WLAN Driver Installation (for WLAN Module)

Thisinformation appliesto 3rd party WLAN modules only. See over for informa-
tion on installing thedriversfor the 3rd party WLAN & Bluetooth combo modules.

If you see the message “Found New Hardwar €’ click Cancel to close the window.

1. Makesurethemoduleispowered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into an attached DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Choose the language you prefer and click Next.

Click Next.

Click Finish to restart the computer.

SOUkLN

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see page 7 - 29).

. |
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3rd Party WLAN Driver Installation (for Combo Module)
Thisinformation appliesto 3rd party WLAN & Bluetooth combo modules only.

If you see the message “Found New Hardwar €’ click Cancel to close the window.

1

arLD

Make surethe moduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Choose the language you prefer and click Next > Next.

Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see page 7 - 29).
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Intel® WLAN Driver Installation

For a standard Intel® WLAN driver installation and configuration choose the Typ-
ical Installation below and use the Windows OS for Wireless LAN control (see
over leaf). If you want to use | ntel® PROSet/WirelessWiFi Connection Utility as
your WLAN interface, and/or add I ntel® MyWifi Technology (Personal AreaNet-
work) see overleaf.

Typical Installation:

1

2.

N UAW

If you see the message “Found New Hardware” click Cancel to close the
window.

Make surethe moduleis powered on, and then insert the Device Drivers
& Utilities + User’'s Manual disc into an attached DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Typical > Install.

Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see “ Connecting to a Wireless Network in Windows 7” on page 7 - 29).
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Custom Installation (for Intel® ProSet and/or Intel® MyWiFi Technology):

Note that if you wish to install Intel® MyWiFi you will need to install Micro-
soft.net Framework 4.0 (or later version) beforeinstalling the driver as per the
procedure below. To get the Microsoft.net Framework file go to the Microsoft
website, search for the file, Download it and then install it.

1. If you see the message “Found New Hardware” click Cancel to close the
window.

2. Makesurethe moduleispowered on, and then insert the Device Drivers

& Utilities + User’s Manual disc into an attached DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next > Custom.

Toinstal Intel® MyWiFi Technology click theicon alongside Intel®

MyWiFi Technology and select “ This feature, and all subfeatures, will be

installed on local hard drive’ (see Figure 7 - 9 on page 7 - 28).

8. Toingtal Intel® PROSet/Wireless WiFi Connection Utility click theicon
alongsideit and select “ This feature, and all subfeatures, will be
installed on local hard drive” (see Figure7 - 9 on page 7 - 28).

9. Click Next > Install > Finish.

10. See“Connecting to a Wireless Network Using I ntel® PROSet Wireless’
on page 7 - 32 or “Intel® My WiFi Configuration” on page 7 - 34 for fur-
ther information.

NoOA®

Wireless LAN Module 7 - 27



Modules

Custom Setup
Select the program features you want to install

Click on an icon in the list below to change how a feature is installed.

Feature Description
[=] Intell WiFi Link Dr
Syt v Lk rver The Intel(R) My WiFi Technology
Intel(R) PROSet/wireless for Bluetooth(R) 3.0 + -
=- provides campanents for
-3 =] IntelR) PROSet/Wireless WiFi Software Personal ares network

connectivity.

Intel(R) My WiFi Technology

This feature will not be available.

< i B

Figure7-9
Install Intel® My WiFi e
Technology & Intel® sk
PROSet/Wireless — e —
WiFi Connection
Utl I I ty c‘i:l’:c‘tsﬂ:gram features you want to install.

Click on an icon in the list below to change how a feature is installed.

Inte\(R) WiFi Lirk Driver
------ ~| intel(R) PROSet/Wireless for Bluetooth(R) 3.0 +
Inte\(R) PROSet/Wireless Wikl Software
----- | i) My Wi Tedmslogy

Feature Description
Intel(R) PROSet/Wireless WiFi
Graphical User Interface
components.

B~ P e e R ke =N [3] | This feature requires 16MB on

>

be installed on local hard drive.

2 This feature, and all subfeatures,

This feature will not be available.

<] ] v

Install to:
C:\Pragram Files\intel\

Instalhield
[ b J[ space | [ <Back [ Mext> |[ caneal |
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Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on. 4
1. Click the taskbar wireless icon ¥, and then double-click an access point to con- Network and
nect to or click to Open Network and Sharing Center if you do not see a network Sharing Center

you want to connect to in the taskbar menu (a list of options will appear allowing
setting changes, and creating a new network).

You can also use the Net-
work and Sharing Cen-

Not connected +3 ¥ Comrol Panel ¢ Network snd Intersat » | Netwonk and Shanng Center ter COI’I'[I‘0| panEI In
_ _ o Windows (Network and
E |Connec‘tion; P available View your basic network information and set up connections. Internet) to Connect to
any available wireless
Wireless Network Connection L) networks.
ZyXEL o
PDA_DLINK !!Hh
CA00 ol
ADSL-LINKSYSY-N ol Flgure 7 - 10
DI-524K il Click Taskbar Icon
DWL-g ol Menu & Network
L} .
& and Sharing Center
carega S’Hiu
Open Network and Sharing Center

4:08 AM
2/11/2011

< P B
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2. You may need to enter a security key for any access point to which you are trying
to connect.
3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.
S
(&) %1 Set Network Location
F| gure 7 _ 11 The network location is now Work
Network Locatlon }, Netwgkﬂame Work.com
Se'[ - Location type: Work

On Work networks, you can see other computers
and devices on the network, and your computer is
discoverable.

View or change settings in Network and Sharing Center

View computers and devices on the network

Close

. |
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5. Click the taskbar icon 4| to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon ll,
click the active connection and then click Disconnect (button).

Security Enabled

it i Networks
Currently connected to:
o You should try to make
No Internet access
sure that any network you
Wireless Network Connection - are connecting to is a se-
pra Connectea Og) | 2 cure network.
Connecting to unsecure net-
ZyXEL o yvorks may allow unauthor-
s ized access to your
PEDHNK Bl computer, documents, web-
CA0D ow sites and files etc.
corega ﬂ!ﬂ
12F
s!m > .
Figure7-12
Open Network and Sharing Center .
Click Taskbar Icon

5:08 AM Menu - Disconnect

< v MW oal 2/11/2011
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Connecting to a Wireless Network Using Intel® PROSet Wireless

(For Intel® WLAN Modules Only)

1. Make sure the Wireless LAN module is on.

2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All
Programs > Intel PROSet Wireless > WiFi Connection Utility).

3. Click to select a network from the found list WiFi network access points, or click
Refresh to update the list.

| Intel® PROSet/Wireless WiFi Connection U

File Tools Advanced Profiles Help

=

WiFi networks found. Select cne and click

Connect.

. WiFi Networks (17)
Figure7-13 [ Thare [oaw T T T-
RD113-DIRB25-2.4G... q
|\%€|(‘? PR(\?\/SIE:U ||I[||]2; This network has secuity ensbled 80
ire e'SS 1 ' |' RD113-DIRB25-56HZ a H
COH n eCtI 0 n Utl I |ty ||U[|[|§ This network, has security enabled é 0
Connect
( ) il

To manans FraMes of praviously connected WiFi networks, dlick t%
Profiles button
l Farvate i T e (S
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4. Click Connect to connect to the select WiFi network access point.
5. If the access point is encrypted then you will need to enter the password and click

O Intel® PROSet/ Wireles
File Tools Advanced Profiles Help

(intel (intel}
WiFi networks found. Select one and click You are connected to
Connect. RD113-DIR855-2.4GHZ-6.
Network Name: RD113-
Speed 1.0 Mbps =
Signal Quality: Wery Good
|P Addiess: 169.254.140016
Intemet Access; Mo
~WiFi Networkg [17) ~ WiiFi Metworks [17)
[ [ Name | Status =
RD113-DIR855-2.4G_.. f|
lll[l[lﬁ This network has security enabled m e
|] <551D not broadcast> <5SID not broadcasts
"l[l 123 T networ has secuy entied |||[|H.§ This ristwaik has securty enabled =}
|]|] <551D not broadcast> <55ID not broadcast> o
||I 2} This network has sscuity snablsd .||[|Hé % eliihes secuiy andbicd I F| gure 7 . 14
<551D not broadcast>
<55ID not broadcast>

il e P - il 4" Intel® PROSet/

cron . e 1117 S ———— -

e T [~ eresn | Wireless WiFi
;fﬂm:;iﬂﬁgf”‘“ of previously connected WiFi networks, click the ;::D ;Hsgtaf:t é:u;uh\es of previously connectad WiFi netwarks, click the CO nn eCtl on Utl | |ty
e Hardwars radia switch . _ ,_ ( nn t| n

7 7
5 Helo? BT ' e Connecting &

Connected)
6. You can turn WiFi On/WiFi Off from the button at the bottom of the Utility.
7. To disconnect, select the connected access point and click Disconnect.

8. Select Help from the menu at the top of the utility (or at the bottom right) to bring
up the Help menu.
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Intel® My WiFi Configuration

a (For Intel® WLAN Modules Only)
Intel® My WiFi Help Intel® My WiFi Technology (Intel® MWT) uses your WLAN to transform your
system into a WiFi Personal Area Network, and enables you wirelessly share your
To get help on Intel® & videos, photos, music with other WiFi enabled devices, while still connecting to the

My WIiFi configuration § |nternet through your WiFi wireless connection.
and settings, access the

Intel® My WiFi Dash- . . .
board from the Start Intel® MWT also features achat function, and offers you the option of being able to
menu (Start > All Pro- & create a WiFi hotspot from your computer. Intel® MWT offers greater range and

grams > Intel PROSet | gneed than other personal area networks, and does not require an access point.
Wireless > Intel(R) My

WiFi Dashboard), or by
clicking the taskbar
iconi#. click the Help
icon in the dash-
board and select a help
topic from the Contents
menu.

. |
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Intel® My WiFi Configuration
Y ou can configure the My WiFi settings as follows.

1. Make sure the Wireless LAN module is on.

2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All
Programs > Intel PROSet Wireless > Intel(R) My WiFi Dashboard), or click the
icon & in the notification area of the taskbar (or right-click and select Open
Dashboard).

3. Aninitial welcome message will appear on the first run of the program (click “Don’t

show this message again” to turn this off in future).

¥ Intel® My Wi Dashboard Figure7 - 15
B Intel® My WiFi
Utility - Welcome

Customize..,
ut dashbard, ping and chat.
M|
f2012

Transfer - Drag and drop files between devices at the speed of 802.11n. No complicated setup, no USH
flash drives.
} Hstagunt - Share It scieis, oc crmate 2 private netbwink fos o deviom.

Heady, Setup. Go.
hust elick O b et statend, raamie your devace, and go.

Open Dashboard

Do Mot Disturb

Learn More, Get More
Learn more or downdoad more [neb® My WiFi Dashboard apps for other systems at s i

B D't st this mesage again

sl D)
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Intel® My WiFi Interface

i ‘j_‘a‘_,'t\bCld rd
o WIE

‘:“1.,2-‘ Sensitivity
E Tt i
Ir Group by type | Search... A\ « T ON/OFF
Hotspot
T on
Con-ﬂguratlon Do Not Disturh
Options & S=e
No devices were found. Preferen S
Figure7 - 16 : .
Intel ® My WI FI Click refresh to check again for nearby devices.

Utility - Interface

"—|
]

RD1A-PC
Your Computer

7 - 36 Wireless LAN Module



Modules

Intel® My WiFi Help
Click the Help icon P¥ in the dashboard to bring up the Help menu and select and
item from the Contents menu to obtain the help information.

- & O

|
Hide: Back Print  Options

i Contents ]ﬁearch1

m Intel(R} My WiFi Dashboard Help

L[] Getting Started i
Nearby Devices tab

E Product overview

- [2] Tum wireless on The Nearby Devices tab lists all of the wired and
[2] Set my devies name wireless devices detected. If there are many E

% Ithng:'vw;l can do devices, they are listed on multiple pages. Click

lain Window Refresh to update the device list. i
ﬂ Mearby Devices tab FI gure 7 - 17

- 7] Favorite Devices tab

- [7] What Can | do Now? tab

- [7] What do those icons mean?
- [7] Refresh the device list

To make a device a favarite device, select the
device, right-click and select Add Favorite. See
Favorite Devices. L4

Intel® My WiFi
Utility - Help

e ﬂ Sensitivity sty

- [7] Search Set sensitivity

- [7] Optiens

- [7] The task carousel The Sensitivity setting controls how devices are
- [7] Wireless displayed, based on their signal strength and

- [2] Hotspot proximity. Decreasing the Sensitivity (-) lists only

- [2] Do Not Disturb devices that are closest to your computer.
Remaving Intel{R) My WiFi Dashboard Increasing the Sensitivity (+) progressively adds
more devices that are farther away.

Group devices by type

Clicking Group by type lists all devices in folders,
based on the type of device. A folder is displayed if
at least one device of that type is found. Double-
< m | v click on a group folder to see what devices are
listed. For examble. vou can open the Computers
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Preferences

Click the Optionsicon [=] and select Prefer ences to configure the options.

Preferences

Preferences
Application | Downloads | Hatspot

Application | Downloads | Hotspat

Ed Whenever[ connect to a device, make it a favorite Download folder:
H Show legacy devices

Ci\Users\RD1ANDownloads
Run this application at startup

Tip: Specify the folder which downloaded files are saved to.

Figure7 - 18
Intel® My WiFi
Utility - Preferences oreferencen
Application | Downloads | Hotspot

Hotspot security settings

Hotspot 5SID: DIRECT-DC- (0l uad
Hotspot password: (REERELY

Intemet connection sharing

g Automatically share my internet connection (w

. |
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Hotspot
Y ou can turn the computer into a hotspot to allow other devicesto connect to it (and
any locally connected devices), and also (if available) the internet.

1. Click the Hotspot icon m to turn the Hotspot on.

2. The Hotspot settings tab shows the SSID and password (you will need to enter
this information when accessing the hotspot from the client computer/device).

3. Click OK to close the Hotspot settings.

(in tel)
. myashboard
\Fi DS
Y

Hotspot settings i
Figure7-19 7
You will need the following information when connecting Intel ® My Wl Fl

another device to this hotspot.
Utility - Hotspot

Hatspot settings
SSID: IRECT-DC-RD1A-PC Do Not Disturh
Password: 12345678 =
Password type: Hex Key
Authentication type: WPA2-Personal
Encryption type: AES-CCMP

Tip: This hotspot is using the default password. For added
securily, consider changing the hotspot password on the
Options dialog.

|
A
RD1A-PC

[l Don't show this message again

. |
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Finding Devices

You can find any Nearby Devices by clicking the Refresh button & in the main
window. Click again at any time to update the list. If alot of devices are found they
will be listed on multiple pages and you can use the left B or right I buttonsto turn
the pages.

Sensitivity

The Sensitivity controls displays available devices based on their signal strength

and proximity e.g decreasing (-) the sensitivity lists only devices closest to the com-
puter’s location.

Group Devicesby Type

If you click Group by typeit will list all devices according to their type in afolder
group. Double-click on any group folder to see the devices of that type listed. There
are 12 possible device types available.

Search
If you want to search for a particular device by name then enter the device namein
the Search field to return results for devices matching the name of the device.
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Favorite Devices
The Favorite Devicestab is where you keep devices to which you connect most of -
ten, and this is particularly useful in environments where many devices are listed

nearby. A favorite device will display theicon §2.
To make any device afavorite just click to select it and select Add Favorite.

(inteD)
WiFt i‘,sashbgam
o W
7 =
N | e
Oebzby /  Group by e
Intel® My WiFi

Utility - Interface
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Connect to a Device

Click the device you want to connect to, and click the connect icon [[EH.

An invitation will be sent to the target device.

The user must then accept the invitation.

After the invitation is accepted the connection will be made.

Use the Windows Network and Sharing Center to set permissions for viewing
and sharing the resources on your computer with another connected computer.

aogrNPE

Further Information

For information on how to block/unblock devices, setting Do Not Disturb, sharing
an internet connection and chat options see “ Intel® My WiFi Help” on page 7 -
37.
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

2. Double-click Windows Mobility Center (Mobile PC).

3. Click the button to Turn wireless off/on, or click the icon il to access the network
menu.

Display @ i = - !!!
ﬁ raghie= ¢ [T Mute 13% remaining o Connected

U i T Q = My C"ustorr'i.lslan ll - [ Turn wireless off

Erightness Volume Battery Status Wireless Metwork Figure 7 = 21
Mo dicol . Windows Mobility
o display o sync = )
l*-- connected @ partnerships W peNE Center

’ Connect display ] ’ Sync settings ] ’ Turn on
External Display Sync Center Presentation Settings
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4

Compatible
Adapters

For a list of compatible
display and audio adapt-
ers check the Intel web-
site, or your service
center.

Intel® Wireless Display Application

The Intel® Wireless Display Application (requires Intel® Centrino WLAN/
Combo module), in conjunction with a compatible video adapter (purchased sep-
arately), alows you to display the contents of the notebook display on another dis-
play (e.g. HDTV) without the need to have cables stretching acrossaroom. Y ou can
then play games, browse the internet, display videos or photo slide shows on your
TV/externa display without using HDMI or A/V cables.

Before configuring the Intel® WiDi application you will need to set up your com-
patible adapter with your display/speakers. Connect the adapter using an HDMI or
A/V cable and turn on the display (or in the case of speakers connect them to the
wireless speaker adapter with the cables provided with the adapter), and then set the
display to the appropriate input channel (see the documentation supplied with your
compatible adapter for full details).

Intel® WiDi aso incorporates I ntel® Wireless Music which allows you to wire-
lessly stream audio from your computer to speakers connected to a compatible
wireless speaker adapter (purchased separately).
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Intel® WiDi Application Installation

1. Insert the Device Drivers & Utilities+ User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 3.Install WiDi AP > Yes.

Click Next.

Click the button to accept the license and click Next.

. Click Finish.

Intel® Wireless Music Driver Installation

If you wish to use your system to stream wireless audio to speakers connected to a
compatible wireless speaker adapter you will need to install the Intel(R) Wireless

OGN WN

Music Driver.

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

2. Click Browse and browse to the driver location (X: denotes your DVD
drive):

o X:\Options\02WL AN\Jacksonpeak\I ntelWireless MusicDriver 1.5.5323.0\auto-

run.exe

3. Click Next.

4. Click the button to accept the license and click Next.

5. Click Finish.

6. Follow the procedure overleaf to setup WiDi or WirelessMusic.

.|
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Intel® WiDi Application Configuration

1. Click Start > All Programs > Intel Corporation > Intel(R) Wireless Display >
Intel(R) Wireless Display, or double click the icon on the desktop.

2. Click | agree to the terms of this license (button).

3. The application will scan for any connected compatible adapters (or you can click
the Scan for available adapters button to enable Intel My WiFi Technology).

Connected adapter

7 Flgure 7 - 22 F Status: No adapter connected. l n tel
Intel® WiDi Scan ;J

Detected adapters

Type MName jin] Model Signal

Intel® My WiFi Technology is disabled.
Please enable Intel My WiFi Technology by clicking 'Scan for available adapters'.
Help me troubleshoot this

(# Indicates an adapter you have previcusly connected to.

d Secan for available adapters )
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Click to select any detected adapters, and click Connect.
The system will then prompt you to enter the 4-digit security code which will be

displayed on the external TV Screen (or press the connect button on the wireless
speaker adapter).
Enter the code for the video adapter and click Continue.

‘-__fm&-

=
Statis: No adagitir connected.

Detected adopters

] Inicatrs a0 sdapter you have precuily cosnectrd 1o

emn foe wmiabie sictens

B D [

Fon WS eV o

Enter security code

T o the st bemer you e sonmcting S P04

Precete enser the d-Se sevusity ende yova ses o your TV sereen

Connected adspter

7 POA
Statue: Comnpcting.

Detected adapters.

T b B [

e e e

=]

arcm canmact

Modules

Figure7- 23
Intel® WiDi Connect
& Enter Security
Code
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4

Test Audio Adapter

To verify a successful
audio connection (for In-
tel® Wireless Music),
select the “Test your
audio connection” link
or select “Finished” to
bypass the test.

You can select “Play
Sample” to play an au-
dio test sample from
your adapter to the con-
nected speaker set.

Figure7-24
Intel® WiDi
Connected

7.

8.

You will then be prompted to enter a name for the video adapter and click

Continue.

Click Finished to complete the setup.

Rename adapter

Lrser n waTiple narme that best descrives your adaper

L

For wareple: “Liing Bocm” se “Bedrocerr, The name & e 1o 1 charsctans. consiring of
the letiars & Bumugh £ nurmioers and punceation manks mept for
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' Status Connected ol
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Bluetooth Module

If your purchase option includes the Combination Wireless LAN & Bluetooth

module (either Intel® or 3rd Party) then install the driver asinstructed overleaf. Wireless Device
o Operation Aboard
Usethe Fn + F12 key combination (see Table 1 - 4, on page 1 - 11) or Control Cen- Aircraft

ter button to toggle power to the Bluetooth module.

4

Bluetooth Data Transfer

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure

the module(s) are OFF if
you are using the computer
aboard aircraft.

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in

one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to

» For 3rd party Bluetooth modules see “ 3rd Party Bluetooth (V4.0) Combo see if the module is pow-
Driver Installation” on page 7 - 50 and “ Standard Bluetooth Configuration in o G
Windows 7" on page 7 - 52. ).

» For Intel Bluetooth modules see the installation procedure see “ I ntel Blue-
tooth Combo Driver Installation” on page 7 - 51 and “ Sandard Bluetooth
Configuration in Windows 7” on page 7 - 52.
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3rd Party Bluetooth (V4.0) Combo Driver Installation

Note this driver is only required for the 3rd Party combo Bluetooth and WLAN
module version 2 (Bluetooth V4.0).

1

Eal SN

Beforeinstalling thedriver make surethe Bluetooth moduleis powered
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties+ User’'s Manual disc into the CD/DVD drive. If aFound New Hard-
ware window appears, click Cancel in all windows that appear, and then
proceed to install the driver as below.

Click Option Drivers (button).

Click 5.Install Combo BT Driver > Yes.

Click Next (if aprompt appears to ask you to turn the Bluetooth power on,
press the Fn + F12 key combination to do so, otherwise the driver will not
be installed).

Click Finish to restart the computer.

See “ Standard Bluetooth Configuration in Windows 7” on page 7 - 52 for
configuration instructions.
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Intel Bluetooth Combo Driver Installation

Notethisdriver isrequired only for the I ntel combo Bluetooth and WLAN module
only.

1.

NoOrWN

Beforeinstalling thedriver make surethe Bluetooth moduleis powered
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties+ User’'s Manual disc into the CD/DVD drive. If aFound New Hard-
ware window appears, click Cancel in all windows that appear, and then
proceed to install the driver as below.

Click Option Drivers (button).

Click 5.Install Combo BT Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Next > Finish.

See over for configuration instructions.

Notethat, at the time of going to press, | ntel® Centrino® Wireless-N 2230, Intel®
Centrino Advanced 6235 WLAN & Bluetooth combo modules use the standard
Bluetooth configuration in Windows 7 (see “ I ntel Bluetooth Combo Driver I nstal-
lation” on page 7 - 51).

Modules

4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.
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Standard Bluetooth Configuration in Windows 7
a For Intel and 3rd Party Driver Version 2 (Bluetooth V4.0) modules only.

Add a Device Setup your Bluetooth Device so the Computer Can Find it
Click Start, and click Con- 1. Turnyour Blu_etoot_h device (e.g. PDA, mobile phone etc._) on. _
trol Panel and then click 2. Make the device discoverable (to do this check your device documentation).

Devices and Printers
(Hardware and Sound). To Turn the Bluetooth Module On

Click Add a device to | 1. Pressthe Fn + F12 key combination to power on the Bluetooth module.
;Tj;f:otﬁogezzs available | 5 A Bluetooth icon [J will appear in the notification area.
' 3. You can then do any of the following to access the Bluetooth Devices control
Bluetooth Module & panel.

Resuming From Sleep

Mod * Double-click the notification area icon E to access the Bluetooth Devices control panel.
oae

* Click/Right-click the notification area icon ﬂ and choose an option from the menu.

The Bluetooth module’s de- :
fault state will be off after — - = Add a Device

J 1w o Devices and Printers + Bluetooth Devices « | 4g W Search Devices and Prinpen Fal R :
: p— Allow a Device to Connect
Addadewe  Addaprnter - @ ‘

Nz s

resuming from the Sleep
power-saving state. Use
the key combination (Fn +
F12) to power on the Blue-
tooth module after the com- Receive a File
puter resumes from Sleep.

Show Bluetooth Devices

Send a File

Join a Personal Area Network

ﬁ;i Open Settings
Figure 7 - 25 Add\ a device Remove Icon
Bluetooth Devices & - g = T 7/14/2009

Click Icon Menu Right-Click Notification Area Icon [J
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To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel and click Add a device. /
2. Double-click the device you want to pair with the computer. o _
- . Pairing Options
(& [F Aadasonce If a device has been pre-
viously connected then
Select a device to add to this computer the pairing option menu

Windows will continue to look for new devices and display them here, Wl" appear When yOU at-
tempt subsequent con-

" M - ;u\;m nections. You can choose
=] — =5 —, to have the computer cre-
l - ) ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

What if Windows doesn't find my device?

Nex Figure7 - 26
Add a Device

3. Onfirst connection the computer will provide you with a pairing code to be entered
onto the device.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

bl Add n device - /
F|gure 7 - 27 Type the following code into your device .

Pairing Code " i Pairing Codes
Example 86855920 t The example outlined here shows a connection to
s e DR e ' a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
¥t pmbicafi s ok code is correct on both devices. Follow the on-

== screen instructions to complete the pairing.

5.  Windows will check to see if any drivers are required to complete the pairing.
6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.
7. Click Close.
d R 'J""'_;‘"I':”'“"‘“""“"“““T EARE B D “-_ - E:"
Figure7 - 28 - =
Pairing Complete & | Wl |
Bluetooth Device ' o s e
Enabled
(o] ‘T‘_j

. |
7 - 54 Bluetooth Module



Modules

To Change Settings for the Bluetooth Device
1. Click the notification area icon and select Show Bluetooth Devices. /
2. Right-click on the device you want to change and click Properties to:

« Change the name of the device (click Bluetooth, type a new name and click OK).
« Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth
To Make your Computer Discoverable to Bluetooth Devices configuration  and  set-
1. Click th tificati . d select O Setti tings, select Help and

. ick the notification area icon and select Open Settings. _ _ Support from the Start
2. Click Options, and make sure that Allow Bluetooth devices to find this

. R menu. Type Bluetooth in
computer check box (Discovery) has a tick inside it. the Search Help box, and

3. Make sure that the Alert me when a new Bluetooth device wants to connect select an item from the re-
check box (Connections) has a tick inside it, if you want to be notified when a turned search results to
Bluetooth device wants to connect. get more information.

0 Eluetooth Settngs [

Culiors | CoM Ports | Hardware

Discovery
J]ialinw Elustnoth deaces to find this computes

{, Toprotect your prvacy. select this cheek bax anly when
you went & Diuetocth device to find this computer.

P —— Figure 7- 29
7| Alest me when a new Bluetonth device wants t conneet B | uetoot h Settin g S -
7 Show the Bluetooth icon in the gotilicetion arex (@) p tions

Bestoee Defaults

o ) [Cconcel | [ sty |
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THX TruStudio &
ST UG
Configuration

Note that THX TruStu-
dio Pro will be dis-
abled when you are
connecting to an exter-
nal display through an
HDMI connection.

THX TruStudio Pro Audio

Note that you will need to install the THX TruStudio audio application in order to
get maximum audio performance. The THX TruStudio AP to allowsyou to config-
ure the audio settings to your requirementsfor the best performancein games, music
and movies.

THX TruStudio AP Installation

1

ONOAAWDN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 7.Install THX TruStudio AP > Yes.

Choose the language you prefer and click Next.

Click Yesto accept the license.

Click Next.

Click Full Installation (button).

Click Next > Finish to restart the computer.
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THX TruStudio Pro Activation
On the first run of THX TruStudio Pro you will need to activate the application.

THX Audio & HDMI

1. To activate the application you will need to be connected to the internet.

2. Double-click the THX Activate icon i€ on the desktop and click the Activate Note that the THX audio

button. actvote effects do not apply to
3. The program will connect to the internet to verify the activation key. audio generated
4. Click Finish to complete the application activation. through an HDMI con-

5. Restart the computer after the process is complete. nection.

THX TruStudio Pro Application

The application can be run from the shortcut in the Start menu (Start > All Pro-
grams> Creative > THX TruStudio Pro Settings).

Power On/Off —®

Figure7 - 30
THX TruStudio Pro
Menu

0 View
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THX Control Panel

Each control has an On/Off button to alow you to enable/disable the control, and
most controls feature a slider to adjust the levels (the subwoofer may be turned on/
off).

Figure7 - 31
THX TruStudio Pro
Controls

» Surround: Provides virtual sound channelsto control the level of immersion.

» Crystalizer: Enhances audio to make it sound livelier.

» Speaker: Enhances the bass level of the sound system.

* Smart Volume: Minimizes sudden volume changes to avoid the need for con-
stant adjustment.

» Dialog Plus: Enhances dialogue levels for movies etc.
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THX TruStudio Pro Headphone Settings

THX TruStudio selects the built-in speakers by default and this setting may cause
some sound quality issueswhen using headphones. To adjust the settingsfor head-
phones do the following:

1. Runthe THX TruStudio Pro application.
2. Select Settings from the menu.

Figure7 - 32
THX TruStudio Pro
S Settings
3. Select Headphones from the drop-down menu (you can adjust the slider for
crossover frequency).
4. Click OK and close the application.
A PaS
“Trustudio PRO" Figure7 - 33

THX TruStudio Pro
Select Headphones

T —
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THX TruStudio Pro & HDMI

1. When you connect an HDMI display to the HDMI-Out port, the THX Tru Studio Pro
controls will be disabled.

2. A warning box will pop-up and will prompt “Do you want to select another audio
device now?”.

3. Click No to continue using the HDMI audio output from your external display (do
not attempt to select another audio device when connected to the external HDMI
display).

THX TruStudio Pro Se

Figure7- 34
THX TruStudio Pro The current selected audio device is disabled, not present, not supported by the
7 HDMI Dlsplay application, or has unplugged jack connections. Do you want to select another
. audio device now?
Warning
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Intel® Rapid Storage Technology Driver

Install the Intel® Rapid Storage Technology to support your SATA driveif set up
in AHCI modein the BIOS (see “ SATA Mode (Advanced Menu)” on page5 - 9)
or if you have set up your hard disksinaRAID configuration (see” Setting Up SATA
RAID or AHCI Mode” on page 7 - 2).

1.

alrwpn

Insert the Device Drivers & Utilities + User’'s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 8.Install IRST Driver > Yes,

Click Next > Next > Yes> Next > Next.

Click Finish to restart the computer (you will need to restart the system
again after the computer has rebooted).

If you have a Solid State Drive (SSD) installed in your secondary hard disk drive
bay you may configure Intel® Smart Response Technology for your system (see
over).
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Intel® Smart Response Technology

Intel® Smart Response Technology is an Intel® Rapid Storage Technology
(RST) caching feature that accelerates computer system performance by using the
SSD as cache memory between the hard disk drive and system memory.

System Requirementsto support Intel® Smart Response Technology:
System BIOS with SATA mode set to RAID (see ““ SATA Mode (Advanced
Menu)” on page5 - 9).

* Intel Rapid Storage Technology software installed.

* A Solid State Drive (SSD) with a minimum capacity of 18.6GB (or with a parti-
tion on the drive formatted to more than 18.6GB e.g a 20GB partition set on the
SSD).

See overleaf for instructions on enabling Intel® Smart Response Technology.

.|
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Enabling Intel Smart Response Technology

1. Runthe Intel® Rapid Storage Technology application from the All Programs
menu.

2. Click Enable acceleration either under Status or Accelerate.

Intel® Smart Response Technology

¥aLr S5rA08 £/TIAN SN DA BOCHATYAAD UTING AN BVEIIADE £310. 2208 BIvE BE 3 ERCRE SAVIE I OR0Ar 1D ATV the VAT DaNEITanCe.

—— Figure7 - 35
Enable
Acceleration

3. Select the SSD to be used as a cache device.

4. Select the size from the SSD to be allocated for the cache memory (any remaining
space on the SSD can be used for data storage using the simple data single-disk
RAID 0 volume that is automatically created).
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Figure7 - 36
Enable
Acceleration
Options

5. Select the HDD (or RAID volume) to be accelerated (it is highly recommended that

you accelerate the system volume or system disk for maximum performance).
6. Select the acceleration mode, and then click OK (Enhanced mode is selected by
default).

Note: Enhanced mode (default): Acceleration optimized for data protection.
Maximized mode: Acceleration optimized for input/output performance.

Enable Acceleration Ll ] 3 =

Select the solid-state drive you want to use to accelerate your storage system:

(®) 55D on port 4: 30 GB

1, WARNING: Completing this action will permanently delete existing data on the selected disk. Back up data
before continuing.

Select the size allocated for the cache memory:

O 18668
® Full disk capacity (maximum 64 GB)

Select the disk or volume to accelerate:

Disk on port 0 (466 GB) (system) v

' 1 L 2. P
1§ Select the boot disk or volume for optimal system acceleration.
Select the acceleration mode:

@ Enhanced mode
O Maximized mode

[ | # Once acceleration is complete, you will need to restart your computer before performing any partition or
formatting operations on the accelerated disk.

More heip oK

7 - 64 Intel® Rapid Storage Technology Driver



Modules

7. The page will refresh and report the new configuration in Acceleration.

s e ol g
| st W Mawge PECEEEEER forieences Help .

Intel® Smart Respanse Technology 2] (4]

Wour f2orape Syvem i configunkd 10 e b sOACate drive B 8 Cache Oevice 10 INCresse sysiem nesoonsiveneIs. enadu faster musti.tasiing. and exdend bectery ife

Accrieration Configuration

Acomernied cevice: Drck o por 1 iuvttee) Cruatie acceseration O

1) You must first cisabe scceleration in orer 30 acceenste a offenent cioc or volume

Acesisration mode Inhansed Cranas moe T

550 Contiguation

840 o ot &t Novmal
Uage Cacra dmvce
Sl pmban VRO 00400

Ay 2001

Vosme Vo 0000

S Figure7 - 37
P Intel® Rapid
ek Storage
Technology
Accelerate

e L3042 ME
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Intel® Rapid Start Technology Driver

Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to
6 seconds and can remember your computer's previous state with zero power.

System Requirementsto support Intel® Rapid Start Technology:

* Rapid Start Technology should be enabled in the BIOS (see ““ Intel (R) Rapid
Start Technology (Advanced Menu)” on page5 - 9).

* Intel Rapid Storage Technology software installed.

* A Solid State Drive (SSD) with a minimum capacity of 18.6GB (or with a parti-
tion on the drive formatted to more than 18.6GB e.g a 20GB partition set on the
SSD).

See overleaf for instructions on enabling Intel® Rapid Start Technology.

.|
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Intel® Rapid Start Technology Configuration

1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R)
Rapid Start Technology (Advanced Menu)” on page 5 - 9).

2. Go the Windows control panel and double-click Administrative Tools (System
and Security)> Computer Management > Storage > Disk Management

3. Right-click the SSD and select Shrink Volume from the menu.

[ 3 computer Manageren — . - ——

File Action View Help

FEE B X & @ o b

agement (Local| [ Volume [ Layout | Type [ File System [ Status [ Capacity [ Free Space | [ Actions
4 [f} System Tools =) Simple Basic Healthy (Hibernation Partition) 4D0GB  4.00GB Disk Management -
> (5 Task Scheduler = (C) Simple Basic NTFS Healthy (Boot, Page File, Crash Dump, Primary Partition) 10268 GB  79.40 GB
> 2] Event Viewer <= (D) Simple Basic NTFS Healthy (Primary Partition) 19531 GB 19522 GB More Actions 4
- @] Shared Folders < My Disc (E) Simple Basic CDFS Healthy (Primary Partition) 247GB OMB
. @ Local Users and Groups||<#New Volume (F) Simple Basic NTFS Healthy (Primary Partition) 1467 GB 1458 GB
. @) Performance ==RCFLASH (G:)  Simple Basic FAT32 Healthy (Active, Primary Partition) 192GB 12068
o System Reserved Simple Basic  NTFS Healthy (System, Active, Primary Partition) 100ME  72ME

= Device Manager
4 3 storage

S Figure7 - 38
Computer
Management

<[ i v
aDisk 0 ! | __________________| (Shl’lnk SSD
Basic System Reser . [C2)
298.09 GB 100 MB NTFS  |/102.68 GB NTFS 195.31 GB NTFS. Vo I u m e
Online Healthy (Syster || Healthy (Boot, Page File, Crash Dump, Prir || Healthy (Primary Partition)
CaDisk 1
Basic New Volume (F:)
18.67 G 14.67 GB NTFS = 3
Online. Healthy (Primary Partition) Explore.
Mark Partition as Active
= Disk 2 I Change Drive Letter and Paths.
Removable RCFLASH (G2) Format...
192 GB FAT32
Online Healthy (Active, Primary Partiti = .
smcvame. ) SNINK MOlume L
<ico-romo I Qg Mirror,
DVD My Disc (E) Delete Volume.
247 GB 2.47 GB CDFS
Online Healthy (Primary Partition) Properties
<[ I3 + || M Unallocsted Ml Primary partition Help
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Figure7- 39
Shrink Volume
Size

4. Enter the figure, which should be equal to amount of system memory (RAM)
in your computer, in “Enter the amount of space to shrink in MB”.

r B
Shrink F: ==
Total size before shrink in MB: 10924
Size of available shrink space in MB: 7802
<\Erw space to shrink in MB: 4036 )
|| Total size after shrink in MB: 6823 |'|
i “fou cannot shrink a volume beyond the point where any unmovable files are located.
i See the "defrag” event in the Application log for detailed information about the
- operation when it has completed.
See Shrink a Basic Volume in Disk Management help for more information.
i
[ swk |[ Cancel |

5. Click Shrink (any unallocated file space may be formatted for storage use).

4

Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB
(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be dis-
played in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6. Click the Start menu and type “CMD” in the search box.
7. Click CMD from the found list.

2 B Administiator: C\Windows\system2\CMD.oxe i . [E=EEER
A Microsoft Windows [Uersion 6.1.76811
mow ) Copyright <> 2089 Microsoft Cowporation. A1l wights reserved.

S o C:\Users P17
wd 1
et
ctup H
Figure7 - 40
wug
e Search for CMD
o Prompt
oy
wtop
i

8. Type “DISKPART".
9. At the DISKPART command type “list disk”.
@ Adrinisteator: CAWindows\system32\CMD.exe - DISKPART | . =R

[C:\Users\P17>DISKPART

Microsoft DiskPart version 6.1.7681
Copyright {G> 1999-2088 Microsoft Corporation.
n computer: P17-PC

DISKPART> list disk H
- . Figure 7.- 41.
@ ap Diskpart - List Disk
18 GB 4897 MB
Online 1967 MB B

.|
Intel® Rapid Start Technology Driver 7 - 69



Modules

10. Type “select disk #” (# is disk number where you want to create the store partition,
so refer to the results obtained from "list disk" for exact disk number).
11. The message “Disk # is now the selected disk.” will appear.

B Administrator; CAWindows\system32\CMD.exe - DISKPART E=SERT)
. C:\Users“P17>DISKPART
Flgure7 - 42 Hicros_ ft DiskPart uers:i.or_l b.1.7681 ;
DISkpart - SeIeCt gspg:;g::gef.?)PigggEZBﬂs Microsoft Corporation.
Disk # DISKPARTY> list disk
Disk ###t Status i o Dyn  Gpt
Online
Online
Online 1967 MB
DISKPART> select disk 1
Dizk 1 is now the selected disk.
DISKPART >
12. Type “create partition primary”.
13. A “DiskPart succeeded in creating the specified partition.” message should
. appear.
Figure7 - 43
DISkpart_ -_Create DISKPART > create partition primary
Partition

DizkPart succeeded in creating the specified partition.

DISKPART > _
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14. Type “detail disk”.

B Administraton C\Windows\system32\CMD.exe - DISKPART =

[DISKPART > detail disk

Uo 1lune_B0AA
Disk ID '?3FB'?EBD

L i RPaI:‘h :chéROOT(E)nPCI(1FEZ)uEnID(PEETEZLEE)
urrent Rea —un y State : -
nly Figure 7 - 44
i e Di Diskpart - Detail
IClustered lh,‘ B .
Disk

Uolume ### Ltr Label i Status

Uolume 4 F New Uolune tion 18 GBE Healthy
|« Uolume 5 Ra i Healthy

IDISKPART >

15. Type “select Volume #” (# is volume of your storage partition so refer to results
obtained from "detail disk" for the exact volume number).
16. The message “Volume # is now the selected volume.” will appeatr.

E Administrator: CAWindows\system32\CMD.exe - DISKPART [E=NEER|

[DISKPART > detail disk

Figure7 - 45
Diskpart - Select
Volume #

[Clustered Di:

Uolume ### Ltr Label Size Status Infn

Uolume 4 F New Uolume NIFS on 18 GB Healthy
< Uolume 5 Rau on 4897 MB  Healthy

[DISKPART> select volume 4_
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17. Type “set id=84 override” (the id must be set to 84).

Figure7 - 46
Diskpart - Set
id=84 Override

18.
19.
20.
21.
Figure7 - 47
Computer
Management
(Healthy
Hibernation
Partition)
22.

B Administrator: C:\Windows\system32\CMD.exe - DISKPART

VUolume ### Ltr Label

Type

Uolume 4 F
< Uolume 5

Neu Uolume NTFS
RaW
[DISKPART > select volume 4

Uolume 4 is the selected volume.
[DISKPARL > set id=84 override
DiskPart successfully set the partition ID.
DI SKPART >

h : PCIROOT (B)nPCI(1FBE)HRRID(PBBTBZLBB)

Partition
Partition

=

Size Status Info

Healthy

14 GB
4897 MB Healthy

The message “DiskPart successfully set the partition ID.” will appear.

Close the CMD window.

Go the Windows control panel and double-click Administrative Tools (System

and Security)> Computer Management

> Storage > Disk Management.

The disk partition should read Healthy Hibernation Partition.

Health§ (Hibernation-Partition

Restart the computer.

298,09 GB 100 Me NTI || 10268 GB NTFS

Online Healthy (Sy | Healthy (Boot, Pacg

i Disk 1 | ]

Basic

18.5.? GB 10,67 GB 4,00 GB
u)‘ {Hibernation Partition)fy

= Dick 7 _
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Intel® Rapid Start Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.

Click Option Drivers (button).

Click 9.Install Rapid Sart Driver > Yes.
Click Next > Next > Yes> Next > Next.
Click Finish to restart the computer.

alrwd

.|
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Chapter 8: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
Overview 8 - 1



Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

» Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sure it is actually working. Check the LED Power Indicators (see“LED Indicators’ on page 1 - 7)
to see the computer’s power status.

» Connections - Check all the cablesto make sure that there are no loose connections anywhere.

» Power Savings- Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Configuring the Power Buttons’ on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

* Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 4, on page 1 - 11).

» Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

» Boot Drive - Make sure there are no optical media and/or USB stor age devices in any connected drive
when you start up your machine (this is a common cause of the message “I nvalid system disk - Replace the
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especialy important if
you choose to use a Boot password for the SCU (see “ Security Menu” on page 5 - 11).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief
notes).

N\ A/
L&
Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-

ranty.
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Viruses

Install an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
gramsto check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don't open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitted “READ ME” or “READ ME FIRST”.

* Wheninstalling a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

.|
Upgrading and Adding New Hardware/Software 8 - 5



Troubleshooting

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.

.|
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Problems & Possible Solutions

Problem

Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator {_111], is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn't start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4) check its settings. You may also be using a USB device/external device
that is drawing a lot of power.

Actual battery operating

The battery has not been fully discharged before being recharged. Make sure the battery is fully

time is shorter than | discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
expected. 11).
Check the settings of any active power plan (see “Power Plans” on page 3 - 4).
A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove the unused device
to save power.
Unwelcome numbers | If the LED is lit, then Num Lock is turned ON. (see “LED Indicators” on page 1 - 7).

appear when typing.
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Problem

Possible Cause - Solution

The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure
you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing
screen.

appears on

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations.
If you're connected to an external monitor, make sure it's plugged in and turned on. You should
also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor |
have plugged in and
powered on.

You haven't installed the video driver and configured it appropriately from the Control Panel. See
“Video Driver Controls” on page C - 1 for instructions on installing and configuring the video
driver.
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Problem Possible Cause - Solution

You forget the boot | If you forget the password, you may have to discharge the battery of the CMOS. Contact your
password. service representative for help.

SN
28

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be | The volume might be set too low. Check the volume control in the Volume Control Panel in the
heard or the volume is | Windows notification area, use the key combination Fn + F5 and F6 to adjust the system volume
very low. (see “Audio Features” on page 2 - 7) to adjust.

The compact disc | The compact disc is dirty. Clean it with a CD-ROM cleaner kit.
cannot be read.

The compact disc tray | The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
will not open when there | hole (see “Loading Discs” on page 2 - 3).
is a disc in the tray.

The DVD regional | The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.
codes can no longer be
changed.

. |
Problems & Possible Solutions 8 - 9



Troubleshooting

Problem

Possible Cause - Solution

The TouchPad doesn't
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

I am sliding my finger up
and down on the right
side of the TouchPad to
scroll a Window and the
TouchPad does not
respond.

There are different TouchPad versions available on this computer, and this version requires
tapping/holding to scroll. Either tap repeatedly, or hold the finger down, at the top or bottom right
of the touchpad (depending on the scrolling direction required) to scroll the window.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes

Power Options features are not enabled. Go to the Windows Power Options menu and enable

into a power saving | the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have
mode. enabled Hibernate mode from the control panel.

The Wireless LAN/ | The modules are off. Check the appropriate LED indicator to see if the modules are on or off (see
Bluetooth/PC Camera | Table 1 - 4, on page 1 - 11). If the LED indicator is not illuminated, then press the appropriate
modules cannot be | function key combination in order to enable the modules.

detected.

The Wireless LAN/ | The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
Bluetooth/PC Camera | for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
modules cannot be | module).

configured.
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Problem

Possible Cause - Solution

When a DVD is played in
Windows Media Player/
Media Center, the audio
track in other languages
(commentaries etc.) is
not clear if connected to
the S/PDIF-Out Jack.

This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-
Out Jack. We recommend that you use the Power DVD application to play DVDs.

Nothing appears on the
screen when the PC
Camera software is run.

You have selected an external display as the default display device. The PC Camera application
software needs to be run while the default notebook LCD is the selected display device.

After a camera picture is obtained on the default notebook LCD, you may then use the Fn + F7 to
toggle through the display modes (give the screen time to refresh).

If you have selected an external display as your display device do not run the PC Camera
software application until you have switched back to the notebook LCD.

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.
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Problem

Possible Cause - Solution

The audio system
performance is below
expectation.

You haven't installed the THX TruStudio Audio application. Install the THX TruStudio application
which helps to get maximum audio performance. See “THX TruStudio Pro Audio” on page 7 -
56.

No sound can be heard

You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page C -

through headphones.

through an HDMI | 22.

connected display.

Audio Volume is too | You have setthe Speaker Configuration to 5.1 or 7.1 Speaker. It is recommended that you set the
low when listening | Speaker Configuration to Stereo (not to 5.1 or 7.1 Speaker) when listening through

headphones in order to maximize audio quality. See “Audio Features” on page 2 - 7.

The THX TruStudio Pro
audio controls don’'t work
when the system is
connected to an external
display through an
HDMI cable.

Note that THX TruStudio Pro will be disabled when you are connecting to an external display
through an HDMI connection. See “THX TruStudio Pro & HDMI” on page B - 24.
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Problem Possible Cause - Solution

The Bluetooth module

is experiencing CETR— et
problems/ 2 Bluetooth Eile  Action View Help File Action View Help
adapters appear in the e 0 HE R RPiles mE B & 2&S
Device Manager under Yoti. ic o~
Bluetooth Radios. 3P Batteries > Batteries
4 -£) Bluetooth Radios 49 Blustoothy Badine
; E.\ Generic Bluetooth Adapter i @ Generic Bluetooth Adapter
g Gener.ic é|LIEtCII.3Eh Radio g Generic Bluetooth Radio
g Microsoft Bluetaoth Enume ; 8 Microsoft Bluetooth Enumerator
- b Computer
i M Computer T !
A » = Dlisk drives

There is a conflict between an existing Bluetooth module and a Bluetooth & WLAN combination
module. You should have only one Bluetooth module installed in order to prevent any
conflicts (this includes the Bluetooth element of any combination WLAN & Bluetooth
module). If you have an existing Bluetooth module installed and then decide to add a combo
WLAN & Bluetooth module at a later date, then uninstall the original Bluetooth module before
installing the combo module.
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Problem Possible Cause - Solution

| cannot obtain high | To obtain high speed Bluetooth data transfer take into account the following:
speed Bluetooth data

transfer. * Only the combination Wireless LAN & Bluetooth module supports high speed
(data transfer.

» To achieve high speed transfer speeds, both devices must support high speed
data transfer (i.e both the computer and the Bluetooth compatible device you
are connecting to).

» To obtain high speed datatransfer make surethat both the computer’'sWLAN
and Bluetooth modules are powered on (use the Fn + F11 to toggle power to
the WLAN module and Fn + F12 to toggle power to the Bluetooth module).

» Check your Bluetooth compatible device's documentation to confirm it supports
high speed data transfer, and for configuration information.
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Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows M obile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Micr osoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
Make sure the Bluetooth device is powered on.

Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

T e

PobdNPE

48 Network adapters

'3 Atheros ARSO0TEG Wireless Network Adapter
l&-"‘ Bluetooth Device (Personal Area Network)
Bluetooth Device (RFCOMM Protocol TDI)

4

Bluetooth Peripheral Devices

You will need to repeat the procedure
listed here for all Bluetooth Peripher-

(w3
£¥ Marvell Yukon 83E8040 PCI-E Fast Ethernet Controller
4|5 Other devices

7 Bluetooth Peripheral Device

dngte ; 7 PCIFLASH Memory
- ¥ Processars
. -4 Sound, video and game controllers

-4 Storage controllers
. Bl Suckarn Aavicar

=

Figure 8 - 1 - Device Manager
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.

7. Click Browse my computer for driver software.

8. Click Let Me pick from a list of device drivers on my computer.

=

Software -

k)
How do you want to search for driver software?
¢ tor updated driver software

cenputer and the Internet for the lsbest drves seftware
you've dissbied this festure in your devsce instalistion

# Search autom

Cameel

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.
@ || Update Driver Software - Bluetooth Peripheral Device

Select your device's type from the list below.

Common hardware types:

Show All Devices
@ 51883 Device Class
@ AVC Devices

3 Batteries
2o

‘ =

Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

@ | Update Driver Software - Bluetooth Peripheral Device

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
disk that contains the driver you want to install, click Have Disk.

Manufacturer || Model

Microlink Weﬂce support
Make sure you select g i

Microsoft Corporation

W Toeed

Mo Cao.

(5] This driver is digitally signed.

Tell me why driver signing is important

N
Ciee D[ Goncel |

Figure 8 - 4 - Select Device Driver
13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

=h Device Manager

=lE =

File Action View Help

e | 7 E HE & %S
4 =, RD01-PC

b 5 Batteries
a- a Bluetooth Radios
a Genenc Bluetooth Radio

: g Disk drives
& Display adapters

> ey DVD/CD-ROM drives

» 82 Human Interface Devices

g IDE ATAJATAPI controllers

,_"3 Imaging devices

b -2z Keyboards

:-B Mice and other pointing devices

b 5] Medems

b A Monitors

:s- &F Network adapters

o l5) Other devices

..l Portable Devices

» T3 Ports (COM & LPT)

b 2 Processors

.s-1‘| Sound, video and game controllers
-8 Systern devices

>~ § Universal Serial Bus controllers

Figure 8 - 5 - Device Manager - Bluetooth Radio

. |
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Intel® WLAN & Bluetooth Combo Modules

Note that, at the time of going to press, Intel® Centrino® Wireless-N 2230 and Intel® Centrino Advanced
6235 WLAN & Bluetooth combo modules use the standard Bluetooth configuration in Windows 7 (see “ I ntel
Bluetooth Combo Driver Installation” on page 7 - 51).

. |
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Installing Windows 7 (pre Service Pack 1) for RAID Systems
with Advanced Format Disks

The following information is only applicable under the following conditions:

* You are configuring your SATA hard disksinaRAID.
* You are using Advanced Format hard disksthat have a4K B physical sector size.
* You are using aWindows 7 version that DOES NOT include Service Pack 1 onthe DVD disc.

Windows 7 versions pre Service Pack 1 (i.e. those that do not include the installation of Service Pack 1 from
the actual DVD disc) require a driver to support Advanced Format hard disks with a 4KB physical sector size
when used in aRAID.

This driver isincluded on the Device Drivers & Ultilities + User’s Manual disc but you will need to go to an
operable computer and copy the driver to a USB Flash drive, external USB hard disk or external floppy disk
drive and floppy diskette, asit isrequired as part of the Windows 7 system installation process.

1. Go to the operable computer and insert a USB Flash drive, external USB hard disk or external USB floppy disk
drive and floppy diskette.

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive of the operable computer.

3. Copy the féflpy-xx folder from the location below (D: denotes your DVD drive) on the Device Drivers &
Utilities + User’s Manual disc to the USB Flash drive, external USB hard disk or floppy diskette.

For Windows 7 32bit = D:\Option\OORA D\f6flpy-x86
For Windows 7 64bit = D:\Option\OORAI D\f6flpy-x64
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4. Press akey at system startup to begin installing Windows from your Microsoft Windows 7 disc (make sure
the DVD device is set at the top of the Boot Sequence in the BIOS - see “Boot Option Priorities (Boot
Menu)” on page 5 - 14).

5. Click Install Now.

Make sure your USB Flash drive, external USB hard disk or external USB floppy disk drive and floppy diskette

is attached to one of the USB ports on the computer.

Click “l accept the license terms” tickbox and click Next.

Click Custom (advanced).

Click to select Load Driver when the “Where do you want to install Windows?” screen appears.

0. Click Browse and browse to the location you copied the files to on your USB Flash drive, external USB hard

disk or external USB floppy disk drive and floppy diskette (X: denotes your USB Flash drive, external USB hard
disk or external USB floppy disk drive):

* Windows 7 32bit - X:\f6flpy-x86\iator.inf
* Windows 7 64bit - X:\f6flpy-x64\iaSor.inf

11. Click Next (or format the drive to your preferences). a
12. Follow the on-screen instructions to install the Windows 7 operating system.
13. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual disc as per Table 4 - 1, on

page 4 - 3 (make sure you install the Intel Rapid Storage Technology driver - see “Intel® Rapid Storage

Technology Driver” on page 7 - 61).

o

B © o~

.|
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
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Ports and Jacks

Item

Description

Card Reader

[ 5D FMMC/ MS

The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

Push the card into the slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

DVI-Out Port

L]

The DVI-Out (Digital Visual Interface) Port is a video connector interface. This allows you to
connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Display
Devices & Options” on page C - 7) by means of a DVI cable. If you are using an older type of
monitor you will need to use a converter to convert the signal from DVI to VGA.

e-SATA/USB 3.0
Combo Port

@< > /e-SATA

This e-SATA (external Serial Advanced Technology Attachment) port allows you to plug-in
external Serial ATA hard drives. This port also serves as a USB 3.0 port.
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Item

Description

HDMI-Out Port
Homi’

The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector
interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on
page C - 8) by means of a HDMI cable. Note that HDMI carries both audio and video signals
(see “HDMI Audio Configuration” on page C - 22).

Headphone-Out Jack

O

Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Microphone-In Jack

%,

Plug an external microphone in to this jack to record on your computer.

RJ-45 LAN Jack

o

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack

:

This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1" or ‘dts’ surround sound.

Security Lock Slot

€33

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.
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Item

Description

USB 2.0/1.1 Ports

o

USB 3.0 Port

o~

These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be
plugged into the computer, and unplugged from the computer, without the need to turn the system
off (if the power rating of your USB device is 500mA or above, make sure you use the power
supply which comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB 3.0 will
transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that USB 3.0 ports require a driver installation (see “USB 3.0” on page 4 - 7), does not sup-
port wake on USB and is not operational under DOS.

A - 4 Interface (Ports & Jacks)




Control Center
Appendix B: Control Center

Overview

Thefollowing chapter will give aquick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down

and move the slider where applicable. Certain functions will automatically be adjusted when a power mode is
selected.

DB

Wireless Bluetooth

L ﬂ ‘E —
Figure B - 1 - Control Center
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Control Center

Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the power status of modules (e.g. WLAN, Bluetooth, 3G or Camera), screen brightness,

TouchPad power and Silent Mode.

You can click aControl Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off any modules etc.

Thetableoverleaf illustrates the basic settingsfor each power mode. If you choose user defined the settings
will correspond to your selected system settings.

. |
B - 2 Control Center



Control Center

. . . . User
Modes Power Saving Flight Entertainment Quiet Performance Defined
1
® A | uw | 2 & &
£3
Power Plan Power Saver Balanced Power Saving Power Saving High Performance
Power Conservation Mode Energy Star BIOS Default Energy Star Energy Star Performance
Brightness Sa- 14 42 100 42 100
WLAN % OFF OFF ON ON ON c
@ @
]
o}
Bluetooth % BIOS Default o
2
(=8
PC Camera m OFF OFF OFF ON ON
3G @ OFF OFF OFF OFF OFF
TouchPad i ON ON OFF ON ON

Table B - 1- Power Modes

Control Center B - 3



Control Center

Power Status @&z
The Power Status icon wiil show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

-,
Brightness ~@~
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or usethe Fn+ F2 key combination to turn off the LED backlight
(pressany key to turn it on again). Note that screen brightnessis also effected by the Power M ode selected (see
TableB - 1, on page B - 3).

Volume w
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Power Conservation

Thissystem supports Ener gy Star power management features that place computers (CPU, hard drive, etc.) into
alow-power sleep modes after a designated period of inactivity (see “ Power Conservation Modes’ on page 3 -
10). Click either the Performance, Balanced or Energy Star button. Click in ablank area of theicon or press
akey on the keyboard to exit Power Conservation M ode without making any changes.

B - 4 Control Center
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Sleep @

Click the Sleep button to bring up the Hiber nate @ or Sleep ® buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “ Power-Saving States” on page 3 - 6). Click in ablank
area of theicon or press akey on the keyboard to exit Power Conservation M ode without making any changes

Display Switch
Click the Display Switch button to access the menu (or use the g + P key combination) and select the appro-
priate attached display mode (see page C - 13).

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background E|
Clicking the Desktop Background button will allow you to change the desktop background picture.

TouchPad/PC Camera/Wireless LAN Module /Bluetooth/3.75G Module ) € R\ %@

Click any of these buttonsto toggle the TouchPad or modul €’ s power status. A crossed out icon will appear over
the top left of theicon @ when it is off. Note that the power status of a module, and TouchPad power, is also
effected by the Power M ode selected (see Table B - 1, on page B - 3). The 3.75G Moduleisan option for M odel
A only.

Caps Lock/Scroll Lock/ Number Lock & & &
Click the button to toggle the appropriate lock mode.

Control Center B - 5
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Video Driver Controls

Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
pagel- 17.

Video Driver Installation

Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3.
Insert the Device Drivers & Utilities+ User’sManual disc and click I nstall Drivers
(button).

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

NVIDIA Video (VGA)

1. Click 3.Install nVIDIA VGA Driver > Yes.

2. Click AGREE AND CONTINUE (button) to accept the terms of the
license agreement.

3. Click Next.

4. Click the RESTART NOW button to restart the computer.

Video Driver Installation C - 1

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your service center for
the latest details on vid-
eo cards supported (see
“Video Adapter Op-
tions” on page D - 4, or
contact your service
center for details).



Video Driver Controls

iGPU or dGPU

Note the NVIDIA control
panel refers to High-
performance NVIDIA
processor (which is the
discrete GPU) and Inte-
grated graphics (which
is the integrated GPU).

NVIDIA® Optimus™ Technology

Most notebook computers come with either adiscr ete or integrated graphics solu-
tion.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based ap-
plications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.

Nvidia® Optimus™ technology is a seamless technology designed to get best per-
formance from the graphics system while allowing longer battery life, without hav-
ing to manually change settings. Thus when an application is run that requires extra
performance or quality, then the system will run the discrete GPU (dGPU); when the
system does not require such enhanced performance it will let the integrated (iGPU)
handle it.

C - 2 NVIDIA® Optimus™ Technology
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How Optimus Technology works

When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU isrun (e.g, agame or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.

4

UMA Mode & Performance

UMA Mode is designed for maximum power saving, however this does have an affect on
the system’s overall video performance (as it is based on the Power saver power plan).

If you require better video performance then it is recommended that you use Optimus
Mode. Alternatively you may switch the UMA Mode power plan to Balanced (however pow-
er savings will be reduced in this case).

Note that when the power plan is set to UMA Mode the GPU LED indicators may no longer
display the correct status.

.|
NVIDIA® Optimus™ Technology C - 3

4

Customization
Options

Although Optimus is
completely seemless to
the user, NVIDIA also
allow customization op-
tions within the control
panel (see “Optimus™
Customization Op-
tions” on page C - 16).
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TableC-1
GPU Button Modes

TableC- 2
GPU LED Indicators

GPU Button
This computer also features abutton ye&) that allows the user to switch between Op-
timusM odeand UM A M ode (Unified Memory Architecture). UMA Modewill use
only the integrated GPU; Optimus M ode will alow the system to automatically de-
termine whether the dGPU or iGPU is used. Thus the user can completely control
how the graphics system operates. Press the GPU button, and the button color will
indicate the current mode.

Icon | Color Description Power Plan
UMA Mode Activated - The system will use the
Green integrated GPU (iGPU) only UMA Mode
@ Optimus Mode Activated - Optimus technology will
Orange | determine when to use the integrated GPU (iGPU) or Balanced

discrete (dGPU) automatically

The GPU LED indicatorswill display which GPU is currently in use.

Icon Color Description
ﬁ Green Integrated GPU (iGPU) Activated
.."'/' Orange Discrete GPU (dGPU) Activated

C - 4 NVIDIA® Optimus™ Technology
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Intel® Graphics & Media Control Panel P

Advanced video configuration options are provided by the Intel® Graphics and

M edia Control Panel. To access the control panel: Applieaiion ek

Note that all figures pic-

1. Cl_ick Advanced settings in t_he Screen_ Resolution control panel in Windows. tured, and instructions
2. Click the Intel(R)... tab and click Graphics Properties (button). suifines e 2 Sres
OR on the Advanced Ap-
3. Right-click the desktop and select Graphics Properties from the menu. plication Mode.

OR

4. Double-click the Intel(R) G&M control panel in Windows.
5. Choose the application mode (Basic, Advanced or Wizard) required (see sidebar).

Generic PP Monitor and Intel(R) HD Graphics 3000 Properties -‘r_
Il [ adapter | monitor | Troubleshost | _ cColor Management | ‘gt Frome
[ Intel(R) Graphics and Media Control Panel | Intel®
A 2 Curent Semings
2 5 . Graphics and Media
Intel® Graphics and Media intel' Control Panel .
Control Panel L__— = F|gure C - 1

Advanced Mode

Intel® G&M
Control Panel

Display  (guittin Display =)

RefieshRate  [60p Hz -]

Rotation  Rotate To Normal =]

5calind | Maintain Display Scaling -

Masintsin Display Scaling ™

Pavwer

Options and Support

Intel® Graphics & Media Control Panel C - 5
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4

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

FigureC- 2
Intel® G&M
Control Panel Tabs

Y ou may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right.
e

gy Promes.

Intel®
Grophics and Medla T
Control Panel

Graphics and Media
Control Panel

Intol®
Graphics and Media
“ontrol Paned

C - 6 Intel® Graphics & Media Control Panel
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Display Devices & Options
Note that you can use an external display connected to the HDMI-Out port or exter-

nal monitor port. See your display device manual to see which formats are support-
ed.

4
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.

Intel Display Mode Description

Single Display One of the connected displays is used as the display device

Both connected displays output the same view and may be

Clone Displays configured independently

Both connected displays are treated as separate devices, and

Extended Desktop act as a virtual desktop

Intel® Graphics & Media Control Panel C - 7

4

Function Key
Combination

You can use the Fn + F7

key combination to tog-

gle through the display

options:

* Notebook Only

» External Display Only

* Notebook + External
Display

Make sure you give the

displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

TableC-3
Display Modes
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4
Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

General Settings

Click General Settings
to access settings the
options for any attached
display.

FigureC- 3
Display > Multiple
Displays (Clone)

Attaching Other Displays

If you prefer to use amonitor or flat panel display, connect it to the external monitor
port or HDMI-Out port.

To Clone Displays:

aorwnE

Attach your display to the external monitor port or HDMI-Out port, and turn it on.
Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
Click Operating Mode and select Clone Displays from the menu.

Click Apply, and OK to confirm the settings change.

You can switch the Primary/Secondary Display from the menu.

Display Profiies

Inloi® Current Settings.

Graphics and Media
Control Panel

Advanced Mode

Options and Support

C - 8 Attaching Other Displays



To Enable Extended Desktop:

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

Go to the Intel(R) G&M control panel and click Display > Multiple Displays.

2.
3. Click Operating Mode and select Extended Desktop from the menu.
4. Click Apply, and OK to confirm the settings change.

@

Display Profiles
Intel®
Graphics and Media
Control Panel

Current Sertings

Operating Made
Advanced Mode
Primary Display ~ Monitor
| Display
Second Display  Built-in Displj
| ‘General Settings
Multiple Displays Positioning
Color Enhancement
‘Custom Resolutions

Monitor / TV Settings

3D

Media

Power

Options and Support

.|
Attaching Other Displays C - 9

Click the appropriate monitor
icon and drag it to match the
physical arrangement you
wish to use (e.g. the second-
ary display may be extended

left/right/above/bel ow
primary display).

the

Click General Settings to
make any adjustments re-

quired.

Video Driver Controls

4

Display Settings
Extended Desktop

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

FigureC-4
Display > Multiple
Displays (Extended)
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Display Profiles
Y ou can save display settings to be loaded at any time.

1. Gotothe Intel(R) G&M control panel and click Display.

2. Configure the General Settings, Multiple Displays, Color Enhancement, Custom
Resolution & Monitor/TV Settings to your preferences.

3. Click Apply, and OK to confirm the settings change.

4. Click the Save button at the top of the General Settings, Multiple Displays or Color
Enhancement menus (under Display Profiles).

5. Type a name for the Profile and click OK.

6. The Profile will be listed under Display Profiles.

7. Select the profile from the pull-down menu and click Apply, and OK to confirm the
settings change.

Display Profiles
FI ure C - 5 Intel® o 5 g
g Geaphics and Media # Clone Displays Brighter
Intel® G&M Control Panel

Profiles

Intel® Graphics and Media Control Panel

Advanced Mode
Create a New Profile

Display i GTVEIL I Clone Displays Brighte-‘l

| General Settings
0K Cancel
Multiple Displays

C - 10 Attaching Other Displays
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Configuring an External Display in Windows 7

Y ou can al so use the Screen Resolution control panel in Windows 7 to configure an

external display.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
Go to the Screen resolution control panel (see page 1 - 18).

2.
3. Click the Detect button.
4. The computer will then detect any attached displays.

4

Function Key
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

o * Notebook Only

g_’ [ ™= < All Control Pane! liems » Display » Screen Resolution « 42 | scorch Cantrot Panet 2 o External Dlsplay
Only

« Notebook + External

Display
[i= Identify
Make sure you give the
displays enough time
Diplay to refresh.
Note that HDMI sup-

Oiientaion:  [Landscape ® ports video and audio
signals.

Change the appearance of your display

Multiple displays: | Duplicate these displays ~

This i currently your main display. Advanced settings

Cennect to a prajector (or press the &F key and tap P)

Make text and other items larger or smaller Flgure C - 6
What display settings should I choose? .
Screen Resolution
Multiple Displays
(Win 7)

Configuring an External Display in Windows 7 C - 11
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5. You can configure the displays from the Multiple Displays menu.

)it B < All Control Panelltems » Display » Screen Resolution | 42 [l s20rch Contrat Pan=i 2

Change the appearance of your display

Idem@
Display: 1|2. Multiple Monitors +
Resolution: 1024 = 768 -

FigureC-7
Screen Resolution
Multiple Display

. Orientation: a
Options
(Wl n 7) Duplicate these displa

Advanced settings

Show desktop only on1
N\Show desktop only on 2 4o p)

What display settings should I choose?

» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)

» Extend these displays - Treats both connected displays as separ ate devices

»  Show desktop only on 1/2 - Only one of your displaysis used.

.|
C - 12 Configuring an External Display in Windows 7
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Using the Windows Logo Key g + P Key Combination to Switch Displays

You can also usethe & + P key combination to quickly change display configura-
tion and modes (thisis particularly useful when attaching a projector) in Windows 7.

Attach your display to the external monitor port or HDMI-Out port, and turn it on.
Press the & + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or 2= + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PonPE

Disconnect Projector Duplicate Extend Projector only Figure C-8
.| a Comiguration
* | g | | | Configuration
: _ Selection
(Win 7)

.|
Configuring an External Display in Windows 7 C - 13
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4

NVIDIA Control
Panel

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

View
Sort by
Refresh
Paste
Paste shortcut
Graphics Properties...
Graphics Options
NVIDIA Control Panel
New

5 Screen resolution

i Gadgets

Personalize

FigureC-9
NVIDIA GeForce.....
Control Panel

NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control

Panel tab.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the
menu if you are in Control Panel Home).

Adjust your computer's settings

ok Indexing Options
¢ g Up

2> Keyboard

—_—
.I.-L Metwork and Sharing
= Center

Parental Controls

#74 Phone and Modem
[L&L Recovery
| P

kﬁ Sound

ng" System

ey O u s e

Media

Location and Other
Sensors

Motification Area Icons ( :

Performance Information
and Tools

Power Options

Region and Language

Speech Recognition

Taskbar and Start Menu

View by: Largeicons ¥

% Internet Options -

J Mouse

L

NVIDIA Control Pane!)

5,‘ Personalization

‘,‘_.:'j Programs and Features

| RemoteApp and Desktop 3
Connections

@ Sync Center

@ Troubleshooting

C - 14 NVIDIA Control Panel
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The NVIDIA Control Panel provides additiona video configuration controls and
tools which allow quick access to features such as image settings, 3D Settings and e

video configuration. Navigating the
e = Control Panel
1| Eile gt:lrt Desktop 3D Settings  Help
Q-0 | O Navigate thrOL_Jgh the
SelectaTack... : = control panels in much
=0 sernge . Adjust Image Settings with Preview 1 the same way as you
__ Restore Defaults
-Mana?e 3DSE:1"GS Jh:‘j page ch:s yo.:dl%Brevielw changis ycu‘ makD? tot;g \mage arédLrendemg settings. These will be your default settings for your WOUId a Web page'
~Set PhysX configuration ardware-accelerate applications that utilize Direct3D or Open .
Y T ” " Click on the sub-head-
Adjust video color settings H H
sl i Brfirr Preview: ing tasks in the left

menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Quality:

mn

What do I look for?

Moving towards the (@) Let the 3D application decide

Performance side will
increase frame rate, (0 Use the advanced 3D image settings ~ Take me there

but curved lines wil
appear jagged.

(©) Use my preference emphasizing: Quality

Maving towards the Frfaritanes Qualicy

St FigureC- 10
NVIDIA Control
Panel

Description:
Toggles between playing and pausing the animation.

Svstem Information HAoply

NVIDIA Control Panel C - 15
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Display GPU
Activity Icon

Click to enable Dis-
play GPU Activity
Icon in the Notifica-
tion Area to quickly
access the GPU Activ-
ity monitor from the
taskbar.

NVIDIA

FigureC- 11
NVIDIA Control
Panel - View

Optimus™ Customization Options

One of the most important aspects of Nvidia® Optimus™ technology is that it will
switch between the integrated GPU and discrete GPU seamlessly and automatically,
and does not require any input from the user. However customization options are of -
fered for users who prefer to set their own parameters for GPU usage.

Context Menu
One of the quickest ways to choose which GPU to use for aparticular applicationis
by using the “Run with graphics processor” in the context menu.

1. Gotothe NVIDIA Control Panel (see page C - 14).
2. Click Desktop from the top menu and select Add “Run with graphics
processor” to Context Menu (it should have a tick alongside it).

| @ Bacl ¥ Add Desktop Context Menu |

¥ Show Netification Tray Icon

SelectaTa? v Add "Run with graphics processor” to Context Menu )
- 3D Settt
i

v Display GPU Activity Icon in Notification Area

Fge Settings with Preview

--Manage 30 settings

..Set PhysX configuration

(1 Video
-Adjust video color settings
i..Adjust video image settings

This page allows you to preview changes you make to the image and rendering setfings. These will be yo
hardware-accelerated 30 applications that utilize Direct 30 or OpenGL.

Performance: Preview:

2

T

C - 16 Optimus™ Customization Options



Close the NVIDIA Control Panel.
Find the executable file icon of the application you want to run.

Right-click the icon and select Run with graphics processor from the context

menu.

Select either High-performance NVIDIA processor (dGPU) or Integrated

graphics (iGPU) to run the program with the selected GPU.

AR X
@uv| . v Computer » Local Disk (C) » Program Files » Internet Explorer » - |¢?| Search Internet Explorer P ‘
Organize = Open Burn New folder =« [l '@'
- Favori Mame Open iType Size s
[ Favorites -
% Run as administrator |
Bl Desktop en-Us : - -
( Runwith graphics processor 3 High-performance NVIDIA processor
4 Downloads . SIGNUP
%] Recent Places 0 ExtEport Unpin from Taskbar Integrated graphics (default)

. Libraries
3 Documents
JT Music
[=| Pictures

E Videos

78 Computer
&, Local Disk (C3)
o Local Disk (D:)
4 DVD RW Drive (E:) M

‘?j MNetwork

(%] hmmapi.dll

Pin to Start Menu

Restore previous versions

Change default graphics processor...

|| ieBprops.propdesc ROPDESC File 3KE
|%| iecompat.dll Send to » Wpplication extens... 2KB
|%| iedvtool.dll - Wpplication extens... 840 KB
u
& ieinstal . Wpplication 251 KB
o
& iclowutil - W pplication 113 KB
%] ieproxy.dll Create shortcut W pplication extens... 159 KB
%] [EShims.dll 'E;‘ Delete W pplication extens... 196 KB
| iessetup.ceb '5‘ Rename ICEB File 3KB
1% iessetup.dll Vipplication extens... 16 KB
= Properties —
| & iexplore pplication 658 KE‘
o 1 T NA Nyl PRAET ? H 12 KB
Right-click the application executabtlefile
%] jsdsBuggeride.d| 17147 :15 Al Application extens... 20 KB
(%] I5ProfilerCore.dll 7/14/2008 9:15 AM  Application extens... 117 KB
D ZvnrrFilow i Al THAPONO AT ARE KBt b 248 vD

m
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iGPU or dGPU

Note the NVIDIA con-
trol panel refers to

High-performance

NVIDIA  processor
(which is the discrete
GPU) and Integrated
graphics (which is the
integrated GPU).

FigureC - 12
Context Menu with
Run with graphics

processor

Optimus™ Customization Options C - 17
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Global Settings

Global settings allows you to set the preferred graphics processor for overall use.

Ideally thiswould be theiGPU for battery life, but this can be set to the dGPU if pre-
ferred.

1. Runthe NVIDIA Control Panel (see page C - 14).

2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).

3. Select either Integrated graphics (iGPU) or High performance NVIDIA
Processor (dGPU) from the drop-down menu.

4. Click the Setting menu items to select any options required.

5. Click Apply to save the settings.

B WITEA Comtrcl Pacel 1)
o = \) — ———
- .m;';:vt B mnm m mms Artore D md ]
Figure C - 13 =xm | *::;‘:;Lt}:u"!;;".l’. S i eme R Bt )
Global Settings T e o e e

Pachics, Y =
r o )
s Samma o
sty v o
U - G
3 At
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Program Settings
Program settings allows you to make specific adjustments for installed applications.

1.
2.
3.

Run the NVIDIA Control Panel (see page C - 14).

Video Driver Controls

Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
Select a program to customize from the drop-down menu, or click Add to add

any program that does not appear in the menu.

Select the preferred graphics processor for the program from the drop-down

menu.

Click the Setting menu items to select any options required.

Click Apply to save the settings.

NVIDIA Control Panel

File Edit Desktop 3D Settings Help

Adjust video image settings

Global Settings | Program Settings

S Program to customzeT

A
@« -© |0 .
m FigureC- 14
Select a Task... elEs .

2D Setings . Manage 3D Settings .

© 7 Adiust inage settngs vith previen o Program Settings

You can change the global 3D settings and create ovemides for specific programs. The ovemides will be us

i -SetPhysX configuration time the specified programs are launched.

= Video

~Adjust videa color settings 1 would like to use the following 3D settings:

\ IB Windows Media Center

Optimus™ Customization Options C - 19
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Set PhysXe Configuration

NVIDIA® PhysX® is a physics engine that can use the GPU to accelerate game and
3D application performance. You can select the GeForce video card or CPU as a
PhysX® processor, or configure the computer to auto-select a PhysX® processor
(recommended default setting).

1. Goto NVIDIA Control Panel (see page C - 14).

2. Click Set PhysX configuration.

3. Click to Select a PhysX processor from the menu; Auto-select (recommended) is
the default setting.

4. Click Apply to save the settings.

hkidt Dpasep 30 Semngn  Help
. Qus -9 B
Flgure C-15 = S _.  Set PhysX configuration
| it sl ik B Restire Dottty
Set PhysX® L [T e ——————
Configuration 2 el e

C - 20 Set PhysX® Configuration
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Video Settings

Click the sub-menus under Video to adjust the video color or image settings.

FigureC - 16
Video Settings

Video Settings C - 21
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Volume Indicator

Click the taskbar volume
indicator [lf when an
HDMI device is select-

ed, and you will note that
the icon at the top of the
volume level indicator
has changed.

©

Mixer

FigureC - 17
Sound - HDMI
Device (set Default)

HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Sound » (Hardware and Sound) and click Playback (tab)

3. Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click Set Default (button).

4. Double-click the device to access the control panel tabs illustrated overleaf.

% Sound &J

Playback |Recording | Sounds | Communications |

Select a playback deyice below to madify its settings: |

< | SONY TV XV-1 TN Configure Speakers
% efault De o Test

Disable

@efault Device )

Set as Default Communication Device

Show Disabled Devices

v | Show Disconnected Devices

Properties

Configure
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5. Adjust the HDMI settings from the control panel tabs.
Click OK to close the Sound » control panel.

6.

(T 508 TV 20-1 Properties

.]  Crangefen |
Controller information

@ VICIA Pigh Definition Audic ._.E?_’f‘.'!.'!?..-
= NVIDRA

Aack Information
LR HOME Degital nck

Devite usage: | Uit this device enabie) =

o J[ oms |

[T 5007 T 20-1 Propertes

=)

| General| Scppertea Fomats | Levet | Enhancements | Advanced|

. SONTTV 3

e F6BowINg Budio TOFMMS afe CUFTently SUDDOMed

Max Humber of Chanaels 2

HOCR: Supperted

B Depth 160
2-bie

Semple Hates:

441 ke

430 ke

Encoded Formats:

o compresved fomats founi.

i SONY TV XV-1 Properties

Selext the eharcements tu sy for your caren] spesker
hanges may . ¥ou start
Haybeck.

I pieabie sl erhancements
o Freeny roecson|
7] Roen Conrextion
7 Lowdess Exusizabion

Eriancement Fropartes

Dieseripisan: Low Frequency Pratecson ciminates
below & specfied cutoff to reduce sudo dstorson

Provider: Muoft

Status: Dessbled | Eetings... |
| Besture Defats | | = Ervien [

Lot ][ ewe |

Detaum | omat

Seirct the sample rate and it depth to be used when unaing
n shared mede,
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FigureC- 18
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Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).

Video Driver Controls

HDMI Notes

Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1.
2.

3.

4.

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Attaching Other
Displays” on page C - 8.

Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

You can now play video/audio sources through your external display.

THX TruStudio Pro & HDMI

1.

2.

When you connect an HDMI display to the HDMI-Out port, the THX TruStudio Pro
controls will be disabled.

A warning box will pop-up and will prompt “Do you want to select another audio
device now?”.

Click No to continue using the HDMI audio output from your external display (do
not attempt to select another audio device when connected to the external HDMI
display.
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Specifications

Appendix D:Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

.|
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Specifications

Intel® Core i7-3820QM (2.7GHz)
Quad-Core Mobile Processor

8M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-3720QM (2.6GHz)
Quad-Core Mobile Processor

6M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-3610QM (2.3GHz)
Quad-Core Mobile Processor

6M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-3520M (2.9GHz)
Mobile Processor

4M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3360M (2.8GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

D - 2 Specifications

Intel® Core i5-3320M (2.6GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3210M (2.5GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i3-3110M (2.4GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i7-2860QM (2.5GHz)
Quad-Core Mobile Processor

8M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2820QM (2.3GHz)
Quad-Core Mobile Processor

8M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2760QM (2.4GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2720QM (2.2GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2670QM (2.2GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 45W

Intel® Core i7-2630QM (2.0GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 45W




Intel® Core i7-2640M (2.8GHz)
Mobile Processor

4M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i7-2620M (2.7GHz)
Mobile Processor

4M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2540M (2.6GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2520M (2.5GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2450M (2.5GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2430M (2.4GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2410M (2.3GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2370M (2.4GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2350M (2.3GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2330M (2.2GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2310M (2.1GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Specifications

Mobile Intel® HM77 Express Chipset

Dual Channel DDRIII (DDR3)

*Three 204 Pin SO-DIMM Sockets
Supporting DDRIII (DDR3) 1333/1600
MHz Memory Modules (real operational
frequency depends on the FSB of the
processor)

*Note: Three SO-DIMMs are only
supported by Quad-Core CPUs; Dual-Core
CPUs support two SO-DIMMs maximum

Memory Expandable up to 24GB
Compatible with 2GB, 4GB or 8GB Modules

17.3" (43.94cm) HD+ (1600 * 900) / FHD
(1920 * 1080), 16:9 Backlit Panel
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Specifications

Intel® Integrated GPU and NVIDIA®
GeForce Video:

Supports NVIDIA® Optimus
Switchable GPU Technology between
iGPU and dGPU

Intel® HD Graphics 4000 / Intel® HD
Graphics 3000 / Intel® HD Graphics
(GPU Type Depends on Processor)
Dynamic Frequency

Intel® Dynamic Video Memory
Technology Supporting Shared Memory
up to 1.7GB

Intel® HD Graphics 4000 Supports
Microsoft DirectX® 11.0

Intel® HD Graphics 3000 / Intel® HD
Graphics Supports Microsoft DirectX® 10.0

nVIDIA® GeForce GTX 660M PCle * 8
Video Chip

2GB GDDRS5 Video RAM On Board
Supports Microsoft DirectX® 11.0
HDMI

NVIDIA PhysX™

GeForce CUDA™ Technology
NVIDIA® Optimus™ 2012 Technology

One 12.7 mm Super Multi/Blu-Ray
Combo/Blu-Ray Writer SATA Optical
Device Drive (Factory Option)

Up to Two (Factory Option) Changeable
2.5" 9.5 mm (h) SATA (Serial) Hard Disks
with RAID Level 0/1 Support

One 48Mb SPI Flash ROM
AMI BIOS

High Definition Audio
S/PDIF Digital Output
Built-In Microphone
2 Built-In Speakers

THX TruStudio Pro

Full Size Isolated Winkey Keyboard with
Numeric Keypad

Built-In TouchPad (with Multi Gesture
Functionality)

Three Instant Buttons; WLAN On/Off,
Mute, Camera On/Off

GPU Mode Button (UMA/Optimus Mode)

One USB 2.0 Port

Three USB 3.0 Ports

One eSATA Port (SATA/USB 3.0 Combo)
One External Monitor Port

One HDMI™-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Microphone-In Jack

One Headphone/Speaker-Out Jack
One S/PDIF Out Jack

One RJ-45 LAN Jack

One DC-In Jack
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Mini-Card Slots for WLAN & Bluetooth
Combo Half Mini-Card Module with PCle
and USB Interface

Embedded Multi-In-1 Push-Push Card
Reader

- MMC / RSMMC

- SD / Mini SD / SDHC / SDXC

- MS /MS Pro/ MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

Built-In 10/100/1000Mb Base-TX Ethernet
LAN

Intel® Centrino Ultimate-N 6300 3*3
(802.11 al/g/n) Half Mini-Card PCle WLAN
Module (Factory Option)

Intel® Centrino Advanced-N 6235 2*2
(802.11 a/g/n) Half Mini-Card PCle WLAN +
Bluetooth V4.0+HS Combo Module (Facto-
ry Option)

Intel® Centrino® Wireless-N 2230 2*2
(802.11 b/g/n) Half Mini-Card PCle WLAN +
Bluetooth V4.0+HS Combo Module (Facto-
ry Option)

(802.11b/g/n) Half Mini-Card PCle WLAN
+ Bluetooth V4.0+LE Combo Module
(Factory Option)

802.11b/g/n Half Mini-Card Module with
PCle Interface (Factory Option)

1.3M Pixel / 2.0M HD PC Video Camera
Module (Factory Option)

Specifications

Security (Kensington® Type) Lock Slot
BIOS Password

Painted Style

Intel® Anti-Theft Technology

Intel® Rapid Start Technology
Intel® Smart Response Technology

Supports Wake on LAN
Supports Wake on USB

Full Range AC/DC Adapter — AC in 100 -
240V, 50 - 60Hz DC Output 19V, 6.3A
(120 Watts)

Removable 8 Cell Smart Lithium lon Battery
Pack 76.96WH
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Specifications

Temperature
Operating: 5°C-35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

413mm (w) * 277.5mm (d) * 17.1 - 44mm (h)
3.2kg with ODD and Battery
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